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Introduction

Axiom Software is an enterprise performance management application with full-featured planning and
reporting functionality. Once the system has been configured to your organization's requirements, plan
files and reports are made accessible to end users. This guide explains how to work with plan files and
reports that have already been created by administrators and other power users.

Intended audience

This guide is intended for all users of Axiom Software.

What is covered in this guide?
This guide covers the following:
o Introduction to the Axiom Software user environment, including menus and basic navigation
o How to use plan files to develop planning data for your responsibility areas
o How to use reports to view Axiom Software data
o File output options

What is not covered in this guide?

This guide does not cover any administration or file setup activities. For more information, see the other
guides delivered with the system. All documentation for Axiom Software can also be accessed using the
Axiom Software Help Files.

Axiom Software Client versions

This guide discusses functionality that is available in the Axiom Excel Client and the Axiom Windows
Client. Screenshots of features may show either client. The Axiom Software functionality is virtually
identical and applies to both clients.

The user features discussed in this document do not apply to the Axiom Web Client or to use of Axiom
forms in any client. When using web-enabled Axiom forms, all user interaction depends on the
configuration of the particular form.
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Axiom Software Basics

This section discusses the basics of working with the Axiom Software user interface, including:
o The Home page
e Axiom ribbon menus
o Axiom Assistant area and task panes

o Favorites and recent items

Home page

The Home page is a designated file that automatically opens when you enter Axiom Software. The Home
file that you see is determined by your system administrator. The Home file may contain report data,
plan deadlines, announcements, or other information. If you have any questions about the Home file or
its contents, please contact your system administrator.

The default label for the Home file is Home. The name may be different if the administrator has assigned
an alternate home file.

e To close the Home file, click the X button in the file tab, or right-click the file tab and select Close.

NOTE: The Close All and Close All But This options do not close the Home file; it must be
individually closed. If you are using the Axiom Excel Client, and the Home file is the last open
file, then closing the Home file will close the application.

o Toreopen the Home file in the current session, click the Show Home button in the Display group
on the Axiom tab. This button can also be used to jump directly to the Home file when multiple
files are currently open.

System administrators can customize the default Home file, or assign each user or role an alternate
Home file. Additional files may also be opened at startup. For more information, see the System
Administration Guide.

Axiom menu

All major Axiom Software files and features can be accessed using the Axiom tab on the ribbon.
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AXIOM Home
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Example Axiom menu (Windows Client)

The Axiom tab contains the following groups:

Group Description

File Groups Access plan files, templates, and drivers. Create and process plan files.

Reports Access existing reports and create new reports.

Administration Manage tables, imports, file groups, security, and other system administration
features.

File Options Perform actions on Axiom files, such as saving the file, refreshing data, and

inserting planning rows.

File Output Perform file output actions on Axiom files, such as taking snapshot copies or using
file processing.

Display Manage display options for the Axiom Software user environment. Show or hide
the Home page, the formula bar, or sheet headings.

Advanced Access file setup tools and other advanced options.

Help Open Axiom Software Help, and view information about the current Axiom
Software system.

Exit Close Axiom Software.

NOTE: This topic discusses the default contents of the Axiom ribbon tab. This ribbon tab can be
customized per installation, or even removed and replaced with other custom ribbon tabs. You may
also be assigned additional custom ribbon tabs that provide access to Axiom Software functionality.

The specific groups and features available on the menu depend on your security settings. For example,
the File Groups group only displays the file groups that you have access to, and only allows opening plan
files unless you have been granted the security rights to access other file group items like drivers and
templates. Most end users will not see the Administration group or the Advanced group, unless they
have been granted access to a feature in that area.

Spreadsheet features are available on other ribbon tabs, to perform spreadsheet formatting and other
related tasks. If you are using the Excel Client, then you have access to all of the normal Microsoft Excel
ribbon tabs. If you are using the Windows Client, a Home tab provides access to commonly-used
spreadsheet features. For more information, see Using spreadsheet features.
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NOTES:

o Administrators have access to a second Axiom-related tab, named Axiom Designer. This tab
can be used to assist with file development.

o When using the Axiom Excel Client with Excel 2013 or 2016, each file opens within its own
window, and each window maintains its own set of ribbon tabs and task panes. This means
that as you switch windows, the current state of the ribbon may be different in each window.
For example, you may have the Home tab active in one window, but if you switch to another
window the Axiom tab will still be active.

Axiom file tabs

You can quickly navigate between open files by using the Axiom file tabs. You can also perform certain
basic file actions directly from these tabs.

You can open multiple files at a time in Axiom Software. Each file that you open—whether it is an Axiom
file or a regular Excel spreadsheet—is represented by an Axiom file tab. These tabs are located below the
ribbon and above the spreadsheet area.
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Multiple file tabs open in the Windows Client

The tab displays the name of the file, and an icon identifying the file type. You can hover your cursor over
the tab to see a tooltip with more information about the file. For example, if the file is a plan file, the
tooltip shows what file group the file belongs to.

You can navigate between files by clicking on the tabs. To close a file, click the X icon in the right-hand

side of the tab. Additional file close options are available on the right-click menu.

Opening multiple files in the Excel Client

When using the Windows Client, multiple files open within the same window. As you move from file to
file, you are changing the active file within the current window.
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Microsoft Excel does not support the ability to open multiple workbooks within the same window.
Therefore when you open multiple files, each file opens in a new Excel window. The Axiom file tabs still
display so that you have access to the right-click menu, however, when you click on a file tab you are
actually changing windows. This action may look confusing as compared to the behavior when the files
are all open in the same window. As an alternative to the file tabs, you can also switch between files
(windows) by using the Windows task bar, or by clicking Alt+Tab to move through open windows.

The one-file-per-window behavior of Excel has the following functionality impacts:

o With the exception of the Home file, Axiom forms do not open as web tabs in Excel. Instead, Axiom
forms will open in the browser.

o The active ribbon tab and the active task pane are managed independently for each open window.
This means that as you change windows, your active ribbon and active task pane may be
different.

File actions in the navigation pane

Right-click on a tab to perform one of the following actions on a file.

NOTE: If you are using the Excel Client, right-click options are only available on the currently active
file. In the Windows Client, right-click options are available on all open files.

Action Description

Save You can save the file using one of the following options:

« Save: Save the file and its data.

o Save File Only: Save only the file; do not perform a save-to-database.

o Save Data Only: Perform a save-to-database but do not save the file.
NOTE: In most cases, you should select Save, and Axiom Software will
perform all save operations that you have rights to perform and that the file
allows. Avoid saving only the file or only the data unless you understand the
potential ramifications. For more details, see the save discussion for the file
type that you are saving (for example, report or plan file).
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Action Description

Save As You can save a copy of the file locally or to the Axiom Software file system (the
Axiom Software database):

o Save As (Local File): Save a copy of the file to any local or network folder
that you have access to. Note that if you save an Axiom file as a local file, it
is no longer managed by Axiom Software.

In the Excel Client, you can save the file using any file format that your
Excel version supports. In the Windows Client, you can save the file as
XLSM, XLSX, or XLS.

NOTE: The ability to save as a local file can be disabled on a per system
basis. For more information on system configuration settings, see the
System Administration Guide.

o Save As (Repository): Save a copy of the file to the Reports Library in the
Axiom Software database (or to another eligible location, depending on
the type of file being saved and your folder permissions). You must have
read/write permissions to at least one folder to use this option. This
option is not available for plan files.

Close Close the current file. This option is not available for startup files that have
been configured as non-closeable.

Close All Close all files except the Home page and any non-closeable startup files.

Close All But This Close all files except the current file, the Home page, and any non-closeable
startup files.

Add to Favorites Add the file to your list of favorites.

File icons in the navigation pane

The following icons display on the file tabs, to identify files in the navigation pane. The table also details
what information displays in the tooltip for each file type:

Icon Description Tooltip Contents
Q The Home file e File name
o File location (in the Axiom Software file
system)

o Creation date

E| Areport file e File name

o Filelocation (in the Axiom Software file
system)

e Creation date
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Icon  Description Tooltip Contents

=] Aplan file o File name
o Filegroup
¢ Plan file code
o Plan code description

o Creation date

Atemplate file e File name

o File group

« Creation date
vy Adriver file o Filename

o Filegroup

o Creation date

H= Atable opened in a spreadsheet e Table name
o Filter
8= An Excel file « Filename

o File location

o Creation date

Axiom Assistant task panes

The Axiom Assistant area provides quick and easy access to Axiom files and features as you work
throughout the Axiom Software system. A variety of task panes are available to help you perform general
and context-sensitive tasks. Additionally, system administrators can create customized task panes for
use in this area.

The Axiom Assistant area is located in the left-hand side of the application, below the ribbon and to the
left of any opened files. By default, the area is expanded, and you can work with any of its available task
panes by clicking the side-tabs along the left-hand edge of the pane.
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The task panes available to you in the Axiom Assistant area depend on your system configuration and
your security permissions. The following task panes may be available:

Task pane

Data Source
Assistant

Explorer

File
Processing

Form
Assistant

User Guide

Description

Helper tool to build data sources,
such as RefreshVariables,
Datalookup, and Grid.

Open files and other items that you
have access to, including favorites.

Configure and perform file processing
for an Axiom file, such as to perform
multipass processing, file collect, or
batch processing.

Configure form settings for an Axiom
file, and preview the form.

Availability

This task paneis system-controlled and
displays if you have the appropriate
security permissions and the file is an
Axiom file.

This task paneis included by default, but
may be disabled in your system or
restricted to only certain users.

This task paneis system-controlled and
displays if you have the appropriate
security permissions and the file is
enabled for File Processing.

This task paneis system-controlled and
displays if you have the appropriate
security permissions and the file is
enabled for Axiom forms.
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Task pane Description

View comments about the current
document, and add comments.

Messages

Notifications  View alert and system notifications

and open associated files.

Process View process information and
complete process tasks. By default
this task pane only displays if it is
relevant to you (for example if you are

the assigned owner of a process task).

Sheet
Assistant

Configure workbook and worksheet
settings for an Axiom file, including
Axiom queries.

Table View table details, set a filter, and

refresh the currently opened table.

Workflow Work with currently assigned plan
files and complete workflow tasks. By
default this task pane only displays if
you have assigned tasks (current or

completed) for an active workflow.

<Custom
Task Panes>

Your organization may have defined
one or more custom task panes for
your system.

Availability

This task pane is system-controlled and
displays for all eligible documents.

This task pane is system-controlled and
displays if you have any active
notifications.

This task paneis included by default, but
may be disabled in your system.

This task pane is system-controlled and
displays if you have the appropriate
security permissions and the file is an
Axiom file.

This task pane is system-controlled and
displays when using Open Table in
Spreadsheet.

This task paneis included by default in
older systems, but may be disabled in
your system or may use different
configuration settings to determine
visibility. Newer systems do not have this
task pane.

Custom task panes may open
automatically when Axiom Software is
launched, or you may have access to the
Task Panes Library to open certain task
panes as needed.

The order of task panes in the Axiom Assistant area cannot be manually changed. Your system
administrator has specified an order for the task panes that open when the system is started. System-
controlled task panes display after these startup task panes.

Minimize Axiom Assistant

By default, the Axiom Assistant area is maximized when you first start Axiom Software. If desired, you can
minimize this area—for example, to gain more screen space while working on a file. When minimized, the
area displays as a thin strip along the left-hand side of the application, with one or more side-tabs for
each task pane.
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You can expand the Axiom Assistant area to perform a task, and then minimize it again when you are
finished.

« To minimize the Axiom Assistant pane, click the * button in the header.

« To expand the Axiom Assistant pane, click the * button in the collapsed header, or click on one of
the task pane tabs.

Axiom Software will remember the state of the Axiom Assistant (minimized or expanded) when you exit
the application, and will apply that state the next time you open Axiom Software on the same machine.

Itis not possible to completely hide the Axiom Assistant area when task panes are open, however, if no
task panes are open then the Axiom Assistant area is automatically hidden (and will automatically show
again when a task paneis opened).

Opening task panes

In most cases, the task panes that you need to use will open automatically—you do not need to
manually open them.

« Certain task panes are configured to open automatically when Axiom Software is started, such as
the Explorer task pane. These task panes are considered to be "global" task panes that you may
want to use at any time while you work in the system.

o Other context-sensitive task panes only open when using certain features. For example, the File
Processing task pane only displays when you open a file that is enabled for File Processing. There
is no need to manually open the task pane because it will always be available when it is relevant
(and assuming that you have security permissions to view it).

If you have access to the Task Panes Library to open certain custom task panes as needed, then you can
open a task pane by double-clicking it in the Explorer task pane or the Axiom Explorer dialog.
Alternatively, one of your "startup" task panes might be used to open other task panes.

For example, you might have access to a Monthly Reporting task pane that details the steps you need to
do to run your monthly reports, and links to those reports. You wouldn't necessarily need this task pane
to be open at all times; instead, you would only want to see it when you are ready to process your
monthly reports. You could open the task pane as needed from the Task Panes Library or from another
custom task pane that links to it.

Closing task panes

Most task panes cannot be manually closed. Either they are global task panes that always apply, or they
are context-sensitive task panes that close automatically when the associated file or feature is closed.
Alternatively, you can minimize the Axiom Assistant area to "hide" all task panes and gain more screen
space for your open files.

If a task pane is closeable, then you can close it by clicking the X icon on the side-tab for the task pane. If
this icon is not present, then the task pane cannot be closed. Typically, only task panes that you open
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manually can be closed manually, but in some cases you may also be able to close task panes that open
on startup.

Using task panes in the Excel Client

When using the Axiom Excel Client, each file opens within its own window, and each window maintains its
own set of ribbon tabs and task panes. This means that as you switch windows, the set of task panes
available in each window may be different. For example:

o Ifyou manually opened a task pane in one window, that task pane will only be present in that
window. It will not be present in other windows.

e The currently active task pane is managed independently for each window, so the active task pane
may change as you change windows. (This can also occur when using the Windows Client, if you
switch between files that have different default task pane associations. However, in the Excel
Client it may also happen when switching between files with the same default task pane
associations.)

o The current state of task panes such as the Explorer task pane is managed independently for each
window. For example, if you expand the Reports Library in one window, that expansion will not be
present if you switch to a different window.

Managing favorites

You can save Axiom files and other items as favorites, for quick access to commonly-used items. Your
favorites list is available in the following locations:

o The Explorer task pane in the Axiom Assistant area

o The Axiom Explorer dialog (if you have permission to access this dialog)

¢ Axiom Assistant
My Files
~ 7r Favorites
E'j Income Statement By Month
(41000
E'j Monthly Package Collect
| ¥ =L Recent

Explorer

3

NOTE: Your organization may choose not to use the Explorer task pane or to restrict it to certain
users. In this case it is likely that your organization will create a custom task pane where you can
access your favorites. However in this case you will not have access to the management features
such as organizing and deleting favorites.

When an item is saved to favorites, you can open the item by double-clicking it, or you can right-click it to
access any other commands that would be available on the item in its native area. For example, if you
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have rights to the Table Library and you save a table as a favorite, you can right-click the table favorite
and perform actions such as editing the table structure.

If an item that a favorite points to is deleted, then the favorite becomes invalid and a red arrow icon
displays next to it. If you attempt to open an invalid favorite, a message box informs you that the item
has been deleted, and asks whether you want to delete the favorite. If a file is moved or renamed within
the Axiom Software file system, but it retains the same document ID, then the shortcut will not be
broken.

Saving favorites
You can save an item as a favorite in one of the following ways:

o Inthe Explorer task pane and the Axiom Explorer dialog, by right-clicking an item and selecting
Add to Favorites.

o By right-clicking the file tab of an opened file and selecting Add to Favorites.

TIP: If you open a table using Open Table in Spreadsheet, and then save the open table as a favorite
(using the file tabs), the settings you used will be automatically saved as part of the favorite, in the
shortcut properties. You may want to rename the favorite to indicate the particular settings (for
example: GL2018 - Filtered for North Region).

Organizing favorites
You can create sub-folders in the Favorites area to organize favorites by folder. To create a new folder,

right-click Favorites and select New Folder.

By default, favorites are displayed in the order that they were added (new favorites are added to the
bottom of the list). You can drag and drop individual favorites to change the order. Sub-folders cannot
be reordered—they will always display in alphabetical order.

To rename a favorite, right-click the item and then select Rename. The name becomes editable, and you
can type a new name.

Shortcut properties

You can edit the shortcut properties for a favorite. Right-click the favorite and select Shortcut Properties.
In this dialog, you can edit the shortcut name, change the shortcut target, and define certain shortcut
properties.

The available shortcut properties vary by file type. For example, you can configure a report favorite to
always open as read-only, or to automatically apply a Quick Filter when opening.

Deleting favorites

To delete a favorite, right-click the item and then select Delete.
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Opening recent files

Axiom Software maintains a list of your recently-opened files. You can use this list for quick access to
recent files.

The recent file list is located in the My Files section of the Explorer task pane and Axiom Explorer. You can
double-click files to open them, or right-click to access the context menu for the file type.

The list displays the last 15 files that you recently opened. Note the following:
o Ifyou want to clear the list, right-click Recent and select Clear History.
o Ifyou want to continue to have quick access to a recent file, you can add it to your favorites.
Right-click the file and select Add to favorites.
o Iftheicon next to a file name s a red arrow, this means that the file has been moved or deleted
since you accessed it, so it can no longer be opened from the recent file list.

In the Windows Client only, recent files can also be accessed from the File menu. In the Excel Client,
although your recent files are tracked in File > Recent, those links point to the temporary versions of the
file stored on your local drive, not the source versions of the files stored in the Axiom Software database.
Therefore, Excel's recent file list cannot be used to open Axiom files.

Viewing notifications in the Notifications task pane

If you receive a notification, the notification will display in the Notifications task pane. This is a system-
controlled task pane that is always available if you have notifications. Click the Notifications tab in the
Axiom Assistant area to view the task pane.

¢ Axiom Assistant

My Maotifications

» 1. Expense variance
alert for UK

Explorer

« /Iy Revenue variance alert
for US East

Revenue variance is negative, please
review,

Workflow

Dpen

» /Iy Revenue variance
alert for US Central

Motifications

Example Notifications task pane
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If you have unread notifications when you first log in, or if you receive new notifications during a current
session, the Notifications tab will flash orange and remain that color until you click on the tab. Unread
notifications display in bold text. Once a notification has been read, the bolding is removed.

Notifications can come from the following sources:

o Alert notifications. Your system administrators and other power users may have set up alerts to
monitor certain alertable conditions and then notify specified users.

« Process management notifications. These notifications result from active processes in process
management, such as to inform you that you have a new task in the process.

+ Message stream notifications. If you have subscribed to a document's message stream, you will
be notified of any new comments made about that document.

o Axiom system processes such as Process Plan Files. If you have triggered certain system
processes, Axiom Software will notify you when the process is completed or when errors occur.

NOTES:

« The Notifications task pane is a system-controlled task pane; you cannot hide or show this
task pane manually. The Notifications task pane always displays on startup if you have any
active notifications (read or unread). Otherwise, it does not display. If you receive a new
notification during a session and the task pane is not already open, this will cause the task
pane to open.

« All notifications displayed in the Notifications task pane are also available in the Notifications
panel of the Web Client container. Both areas read from the same source of notifications, and
edit the same source as well. So if you mark a notification as read in one area, or delete a
notification from one area, the other area will reflect these changes.

Reviewing notifications

Within the task pane, notifications are listed in the order they were created, with the newest notifications
at the top. Each notification displays a severity icon and an alert title, as well as how old the notification
is. The following severity icons are used:

. 0 Info
e % Warning
o ! Error

To read the notification text, double-click the notification to expand it. The text should provide you with
more information about the notification and why you are receiving it. You can double-click the
notification again to collapse it.

If the notification is from an alert, then the alert creator may have specified a document that you can
open to see more information about the alert condition. If so, then you will see an Open link underneath
the message text when you expand the notification. Click this link to open the associated document.
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Notification actions

You can select one or more notifications and then right-click to perform the following additional actions:
+ Mark Read: Mark the selected notifications as read.
o Mark Unread: Mark the selected notifications as unread.

o GoTo Alert Definition: Open the source document for the alert, if you have permission to access
the file. You will be taken directly to the specific alert definition that generated the notification.

o Delete: Delete the selected notifications. Keep in mind that once a notification has been deleted,
you cannot undo this action.

Commenting on documents in the Message Stream task
pane

When viewing a managed Axiom file or form within the Desktop Client, you can view comments that
other users have made about the document and also make comments about the document. New
comments will be stored in the message stream for that document, so that all other users who access
the document can see the comment. Additionally, you can "tag" other users in the comment, so that the
tagged users are notified about the comment.

You can view comments and add comments using the Message Stream task pane. This is a system-
controlled task pane that automatically opens for eligible documents.

NOTES:

o The message stream is only available for documents where it has been enabled, using the
Enable Message Stream option on the file's Control Sheet.

o The message stream is also available for Axiom forms that are opened in the Web Client, using
the Message Stream panel in the Web Client container.

Viewing the message stream

To view the message stream for the current document, click the Message Stream tab to display the task
pane in the Axiom Assistant sidebar. This task pane shows all comments that have been made about the
document.
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Comments are displayed in the order they were made, with the most recent comment shown at the top
of the panel. Each comment shows when the comment was made and the user who made it.

To view the full text and details of a comment, hover your cursor over the comment so that the > symbol
displays on the right-hand side of the comment. Click the symbol to open a separate Comment Details
dialog with the full comment text.

Once the message stream has been loaded for the current document, it is only updated automatically
after you add a new comment. If necessary, you can manually refresh the task pane to see if any other
users have made comments during the current file session.

Comments are stored for the life of the document, and cannot be deleted.

Adding a comment

To add a comment, click Add Comment at the top of the Message Stream task pane. In the Add
Comment dialog, you can define an optional title for the comment, and then define the comment text.
Basic text formatting of bold, italic, and underline can be used.
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Post Cancel

If desired, you can "tag" one or more users in the comment, so that those users are notified about the
comment. Any user tagged in the comment will receive an email that contains the content of the
comment and a link to the document. To tag a user, use the Tag user box to find a user and insert the
tag. You can type into the box to find a specific user, or select a user from the drop-down list. When you
click on a user name in the list, a tag will be inserted at the current cursor point in the comment text. The

tag displays as @ Fi rstName LastName.

When you click Post, the comment is saved to the message stream, and any tagged users will be notified.

NOTES:
o All users with access to the document can see comments posted to the message stream. Any
comments made should be appropriate for the entire document audience. Do not post any
sensitive information to the message stream.

o Adding a comment automatically subscribes you to the document's message stream, and
tagging a user automatically subscribes that user to the document's message stream.

Ongoing notifications (subscriptions)

If you have made a comment in a document's message stream, or if you have been tagged in a
comment, you are now subscribed to that document's message stream. Whenever a new comment is
made to that document's message stream, you will receive a notification in the Notifications task

panepanel.
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The notification details the user who made the comment and when it was made, the text of the
comment, and a link to open the file.

Currently it is not possible to unsubscribe from a document's message stream once you have been
subscribed.

Using the Explorer task pane

Using the Explorer task pane, you can quickly access your favorites, recent items, and all Axiom files that
you have rights to access.

The Explorer task pane is a streamlined version of the Axiom Explorer dialog. Most features available in
Axiom Explorer are also available in the task pane, if you have the appropriate security rights to access
those features.

The Explorer task pane is available in the Axiom Assistant area. To view the Explorer task pane, click the
Explorer tab along the left-hand side of the Axiom Assistant area.

NOTE: The Explorer task pane is provided by default, but it may be disabled in your system or
restricted to only certain users. If you are an administrator and you want to disable or restrict access
to the Explorer task pane, see the System Administration Guide.

The Explorer task pane is organized into sections. You can collapse and expand each section by clicking
on the arrow button in the right-hand side of the section header.

Explorer Section Description

My Files Contains the following:

« Favorites: Your personal list of favorites. For more information on saving
and managing favorites, see Managing favorites.

o Recent: Alist of your recently-opened items. This list displays the last 15
items that you opened. If desired, you can clear the list by right-clicking
Recent and selecting Clear History.

o My Documents: A "personal” folder within the Axiom Software file system
where you can save documents. Only administrators and users with the
User Documents Folder Access security permission have access to this
feature.

NOTE: Ifa red arrow icon displays next to an item in Favorites or Recent, this
means that the item the shortcut points to has been subsequently deleted.

Moving or renaming an item will not break a shortcut, since files are tracked
using the document ID.
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Explorer Section Description

File Groups Contains the file groups that you have access to.

End users can open plan files from this area. Administrators and other users
with special feature permissions can manage file groups from this area.

By default, file groups display in categories. If you are not using categories, or
if you just want to change the view to display by file groups, you can do this
by right-clicking the File Groups header.

Libraries Contains the Axiom libraries and files that you have access to. You may have
access to one or more of the following: Reports Library, Scheduler Jobs
Library, Task Panes Library, Ribbon Tabs Library, Imports Library, Exports
Library, Process Definitions Library, and Table Library.

Most end users will only have access to the Reports Library. Administrators
and other users with special feature permissions can manage items from this
area.

Axiom System Contains Axiom system files. Only administrators have access to this area.

Using the Process task pane

The Process Management feature can be used to manage and track any Axiom-related process. A
process is a series of defined steps that represent the tasks to be completed. If you are the assigned
owner of a step in a process, then it is your responsibility to perform the necessary task and mark the
step as complete by the specified due date. You can do this by using the Process task pane.

The Process task pane displays automatically when you are the owner of an active step in a process. The
task pane displays one or more processes in which you have active tasks. The process summary displays
the process name and the number of active tasks you have in the process.

To view your active tasks in a process, click the arrow button on the left-hand side to expand the process
(or double-click the process summary). Your active task(s) are listed underneath. For each task you can
see the step name, the due date, and any additional details about the step. The following screenshot
shows an example Process task pane with an active task:
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Using the Process task pane, you can do the following:

o Open associated files and features: Some tasks may have a link to an associated file or feature, to
help you perform the task. Other tasks do not have these links. If no link is present, then you will
need to manually navigate to any file or feature needed to perform the task.

o Complete the step: When you have finished your task, you must mark the step as complete. In
most cases you do this by clicking Mark step as complete.

However, there is also a special type of step known as an "approval step." In this case you must
indicate whether you approve the process to continue by clicking either Approve or Reject.
Approve means that the process will move to the next step, and Reject means that the process
will return to the prior step.

o View the entire process: By default, only your active step is shown in the task pane. In some
cases, you may have the option to view all steps in the process, so that you can see how your
active step relates to the overall process. If this option is present in the task pane, then click Show
process view to see all steps in the process, including previously completed steps and steps to be
performed in the future. This view is for information only; you cannot complete steps in Process
View. To return to Task View, click Show task view. Process View is only available to step owners if
the process has been configured to allow access to it.

Step types

Each step listed in the Process task pane has an icon that indicates what type of step it is.

Icon Step Type Description
5 Approval This step requires you to approve the process to continue to the next

step, or reject the process to return it to the prior step.

% Edit Plan File This step requires you to work on a plan file.
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Icon Step Type Description
File Group This step requires you to perform a task on a file group.
Generic This step can require you to perform any kind of task.

Import This step requires you to perform a task on an import.

2 05| @| &

Multiple This step is a Multiple Approvals Step, which means that all the sub-

Approvals steps underneath it can be performed in any order instead of
sequentially. You may be responsible for one or more sub-steps of
the subprocess.

NOTE: This icon only displays in Process View, where you can see the
parent step as well as all sub-steps. Parent steps do not display in
Task View; only currently active sub-steps show.

T Parallel This step is a Parallel Subprocess, which means that all the sub-steps
Subprocess underneath it can be performed in any order instead of sequentially.
You may be responsible for one or more sub-steps of the subprocess.

NOTE: This icon only displays in Process View, where you can see the
parent step as well as all sub-steps. Parent steps do not display in
Task View; only currently active sub-steps show.

B Report This step requires you to perform a task on a report.

[ER Scheduler This step automatically runs a designated Scheduler job. The status
of the job displays in the task pane for your information only. Under
normal circumstances, you do not need to do anything to complete
this step, all job processing and step completion occurs
automatically.

= Table This step requires you to perform a task on a table.

With the exception of the Scheduler step type, keep in mind that Axiom Software does not automate any
of the tasks. Although a file or feature may be associated with a step, it is still up to you to use that file or

feature as necessary to perform the task. Other tasks may not be associated with any file or feature, and

it is up to you to perform the task as necessary.

If you are unclear what needs to be done to perform the task, make sure to review the step description

(in the step tooltip) and then contact your system administrator if you have any further questions.

Completing steps

To complete a step, click Mark step as complete (or click Approve / Reject if the step is an approval
step). This opens the Process Action dialog.
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The diagram at the top of the dialog shows the current step, the next step, and the previous step (when
rejecting only). If you are completing or approving the current step, the process will move forward to the
next step. If you are rejecting the current step, the process will move back to the prior step.

If desired, you can enter a comment into the Comment box. This comment will be saved in the process

history, and in most cases will also be included in the notification to the next step owner (if notifications
are enabled).

@ Mark process step as completed in process 'Monthly Updates'.

Current Step Next Step

L Import monthly actuals Run tie cut report

& Fred Eubanks (feubanks) & Jane Doe

Comment: Any comment will be stored with the process and included in notifications to the next step owner.
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NOTES:

o Ifthe step you are completing is a child approval step of a multiple approvals step, then the
"next step" is the top-level step that comes after the multiple approvals step. However, there
may still be other active child approval steps that need to be completed before the process
moves to that next top-level step. If you approve the step and enter a comment, the
comment will be included in the notification to the next step owner once all of the child steps
are complete.

o Ifthe step you are completing is part of a parallel subprocess, then only the current step
displays at the top of the dialog. This is because the parallel steps can be completed in any
order, and completing the current step will not necessarily move the process to the next step
(that will only happen when all of the parallel steps are complete). In this situation, any
comment entered is only saved in the process history, it is not included in an email to the next
step owner.

o Ifthe step you are completing is a File Group step that involved cloning a file group, and the
new file group is referenced by subsequent steps, then you must specify the name of the file
group that was created as a result of the step. Axiom Software will attempt to guess the
correct file group; if the guess is not correct then you can use the drop-down list in the step
completion dialog to specify the correct file group. The dialog will only list clones of the target
file group for the step.

« Ifyou are the assigned owner of a Scheduler Process Step, then by default you do not need to
do anything to complete the step—it will be completed automatically if the Scheduler job
processes without error. However, if the job experiences errors then you will have the options
to Restart scheduled job (assuming that the issue that caused the error has been resolved) or
to Mark step as complete (assuming that the job does not need to be run again in order to
consider the step completed).

If the step you completed was your only active task, then the Process task pane will be empty for the
remainder of the current session, and will not open the next time you log in (unless you have been
assigned a new active task). The task pane will remain open if you have other active tasks in this process
or another process, or if you are an administrator. The Process task pane is available to administrators as
long as any processes are active.

Completing steps for multiple plan files

Ifthe process is a plan file process, then the steps in the process are performed for each individual plan
file in the file group. In this case, you may be responsible for completing the task for multiple plan files.

If you are responsible for multiple plan files, then those files are listed with check boxes in the Process
Action dialog. You can select one or more check boxes to complete the step for those plan files.
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P Administrator features

If you are an administrator, then by default the task pane shows all active processes for which you have
an active task, as well as all active processes for which you are the process owner. If desired, you also
have the option to change the view to show all active processes. At the top of the task pane, use the
Show all processes toggle to see all active processes. To go back to only viewing your processes, click
Show my processes only.
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Administrators and process owners can also perform the following actions in the task pane:
o Click View status to view the Process Status dialog for the process.
o Right-click a process and select Stop Process to stop the process.

o Toggle between Show process view and Show task view. However, if you do not currently have
any active tasks in the process, then you can only use Process View.

Using the Workflow task pane

The Workflow task pane displays in the Axiom Assistant area when you have any current workflow tasks.
You can use this pane to review all of your workflow tasks, open your assigned plan files, and complete
your currently assigned tasks.

NOTE: The Workflow task pane is provided by default, but can be disabled in your system or
restricted to only certain users. The visibility settings of the task pane can also be adjusted—for
example, so that it is always visible. If you are an administrator and you want to disable or restrict
access to the Workflow task pane, or change the visibility settings, or include the controlin a
separate custom task pane, see the System Administration Guide.

The Workflow task pane displays all of your current workflow tasks. If you have no current tasks, then
the list will be blank. In this case, the Workflow task pane may not display at all, depending on how it is
configured for your organization.

The list is organized by workflow name in a treeview. The plan files that are currently assigned to you are
listed underneath the workflow name. The plan files may be listed directly underneath the workflow
name, or they may also be organized by a grouping (such as by region, VP, or manager). The due date for
each plan file is listed to the right of the plan file name. Plan files are sorted by their display name.

Workflow Tasks -~ Workfow Tasks "
e : Active Plan Files: (7) 3
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|z_|f|2?DUﬂ (Human Resources)
(4] 28000 (Facilities)

(h) 29000 (Legal)

¢ ERegion India (1)

v ERegion Haly (2)

’ %Reginn Singapore (1)
v ERegion US Central (1)
+ ZjRegion US East (2)

ER|41500 (New York War...
'Dpen| Submit| Zh (New Yo .ar
(42500 (New York Dist...

Example Workflow task pane 5
Open| | Submit |

Example Workflow task pane with grouping

LA LA LA LA

Selected Plan Files: 1
e

LA LA

YT P )

User Guide Axiom Software | 25



To perform a workflow action on one or more plan files, select them in the list. You can select individual
plan files, or you can select multiple plan files by using the SHIFT or CTRL keys. You can also select a
grouping (if applicable) to perform the action on all plan files in the grouping. The following workflow
actions are available:

e Open: Open the selected plan files.

o Submit: Complete the workflow tasks for the selected plan files by submitting them to the next
stage in the workflow. This action applies if the plan files are in an edit stage.

o Approve: Complete the workflow tasks for the selected plan files by approving them to the next
stage in the workflow. This action applies if the plan files are in a review stage.

o Reject: Complete the workflow tasks for the selected plan files by rejecting them to the prior stage
in the workflow. This action applies if the plan files are in a review stage.

NOTE: If you select some plan files that are in an edit stage and others that are in a review stage, then
the workflow action is Submit, which means that any plan files in a review stage will be approved. If
you want to reject some plan files in the review stage, you will need to select those files separately.

The workflow data is current as of when Axiom Software was launched. To refresh the data, click the
refresh icon '© at the top of the pane.

Using spreadsheet features

All Axiom files—plan files, reports, templates, and drivers—are Microsoft Excel spreadsheets. In addition
to Axiom Software features, you can use spreadsheet features for formatting, formulas, and other
functions.

NOTE: Your organization may choose to deploy certain files as web-enabled Axiom forms instead of
as spreadsheets. In this case you will interact with the file as if it were a web page, and spreadsheet
features will not be available.

Using spreadsheet features in the Excel Client

When you work on Axiom files in the Axiom Software Excel Client, all of the features of Microsoft Excel are
available to you. You can use standard Excel features to format cells, create charts and graphs, create
formulas, etc.

Where appropriate, standard Excel menus and shortcuts can be used to perform their equivalent Axiom
Software function. For example, if you want to save an Axiom file, you can click Save on the Axiom tab of
the ribbon, or you can use the Excel menu Save command (or Excel's keyboard shortcut of CTRL+S).
However, note that you cannot use Excel's file Open command to open files that are stored in the Axiom
Software database—managed Axiom files must be opened using Axiom menu commands.
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While you are working in the Excel Client, you can open "regular" Excel spreadsheets and work with them
as normal alongside any Axiom files that you have open. You do not need to open another Excel session
or close your Axiom Software session in order to work with regular Excel files.

Using spreadsheet features in the Windows Client

The Axiom Software Windows Client emulates the Microsoft Excel spreadsheet environment. While the
spreadsheet itself and the Axiom file features are essentially the same in either client, the way that you
work with spreadsheet features is different in the Windows Client.

In the Windows Client, you access spreadsheet features from the following locations:

File menu: Similar to the File menu in Excel, this menu provides access to basic commands such as
Open, Close, Print, and Save.

Home tab: Similar to the Home tab in Excel, this tab contains some common spreadsheet
formatting commands such as copy and paste, font and number formatting, and other cell and
sheet formatting options.

Range Explorer: Using the Range Explorer, you can format cells and define cell-related features
such as validation and conditional formatting. Available from the Axiom Button and the right-click
menu.

Workbook Explorer: Using the Workbook Explorer, you can add and delete sheets, and work with
sheet-level settings. You can also define named ranges. Available from the Axiom Button and the
right-click menu.

Display: In the Display group on the Axiom tab, you can toggle the formula bar and row / column
headings on and off.

For example, the following list details some common spreadsheet actions and how to perform them in
the Windows Client:

To open a non-managed spreadsheet file: From the File menu, click Open.

To change the name of a sheet: On the Home tab, in the Cells group, click Format > Rename
Sheet.

To add a sheet to a file: On the Home tab, in the Cells group, click Insert > Insert Sheet.

To set row width or column height: On the Home tab, in the Cells group, click Format > Row
Height or Format > Column Width.

To hide or unhide a sheet: On the Home tab, in the Cells group, click Format > Hide & Unhide.

Changing your Axiom Software password

If your authentication method is Axiom Prompt, you can change your password as needed. This feature
does not apply to users who are using any other authentication method (such as Windows User
Authentication), because those passwords are controlled externally from Axiom Software.
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To change your password:
1. Onthe Axiom tab, in the Help group, click Help > Change Password.

This command is only available to Axiom Prompt users.

2. Inthe Set Password dialog, enter your current password, then enter and confirm your new
password.

If password rules are being enforced, your password must meet the rules. A validation message
will inform you of the rules if necessary. Alternatively you can click Generate Password to auto-
generate a password that meets the rules. If you do this, make sure to note the generated
password because you will not have another opportunity to see it. If you do not note the
password and cannot log in later, an administrator will need to reset your password.

3. Click OK.

Your password is now changed. You will need to use this new password the next time that you log in.

Closing Axiom files

You can close an Axiom file in one of the following ways:
o Click the X in the right-hand side of the file tab.

« Right-click the file tab and select Close or Close All. Note that using Close All will not close the
Home file.

o Click File > Close.
o Click the lower X in the right-hand side of the application window (Microsoft Excel only).

If the file has any unsaved changes, you will be prompted to save the file before it is closed.

If you are using Excel 2013 or 2016, and you close all open files, then the application will automatically
close. In all other Excel versions and in the Windows Client, the application will remain open with a blank
file area.

If close options are not available for a particular file, such as the Home file, that means the file has been
designated as "non-closeable" by a system administrator. This file is intended to always remain open
while you are in Axiom Software.

Closing multiple files

When using Close All or Close All But This, or when closing the application with open files, Axiom
Software checks all files for unsaved changes before closing. If any are found, the Save Modified Items
dialog opens, listing each file with unsaved changes.

By default, all modified read/write files are selected to save before closing. If you do not want to save a
particular file, clear the check box for that file. You can also use the Select All and Clear All options.
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If you choose to save files as part of the close, this will perform a full save (both saving the file and
performing a save-to-database if applicable).

Closing Axiom Software

To close Axiom Software, click the Close Axiom Software button in the Exit group of the Axiom tab. You
can also simply close the application by clicking the X button in the top right-hand corner of the window.
You will be prompted to save any changed but unsaved files.

If you are using the Axiom Excel Client, there is no way to close Axiom Software and leave Microsoft Excel

open. If you want to work with an Excel file, you can open the file within Axiom Software, or you can open
a second Excel session.
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Using Plan Files

Plan files are used to develop planning data and save that data to the database. This section explains the
basic concepts behind plan files and how to use them.

This section is intended for end users working with existing plan files, to develop and review plans. If you
have rights to administer file groups and their components, see the File Group Administration Guide and
the Axiom File Setup Guide.

In addition to the plan-specific functionality detailed in this section, you can use standard Axiom file
features and tools. Plan files use the same functionality as other Axiom files to perform actions such as
changing views or navigating to file bookmarks. For more information, see Using Axiom File Features and
Printing Files and other File Output Options.

About plan files

Using plan files, you can develop planning data for your responsibility areas and save that data to the

database.
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Each plan file is created as a copy of an assigned template. After the file is created, certain sheets might
have rows of data and calculations inserted automatically, unique to the particular plan code. You can
then input data, create additional calculations, add comments, and insert new rows as needed using calc
method libraries.
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Plan files are associated with a file group, which is a set of files supporting a specific planning effort. You
may have access to multiple file groups.

Your organization may use file groups to manage multiple planning processes (for example, a "Budget"
file group and a "Forecast" file group), and/or each file group may represent a specific planning cycle (for
example, the "2018 Budget" file group). If you have any questions regarding the purpose of each file
group, please contact your administrator.

Generally, there is a plan file for each plan code within the designated planning dimension for the file
group. For example, budgets are typically done at a department level, but forecasts are often done at a
divisional or regional level. The Budget file group would have a plan file for each department, and the
Forecast file group would have a plan file for each division. Planning can be performed at any level.

Plan file structure

Plan files are Microsoft Excel spreadsheets that are managed and enhanced by Axiom Software. You can
use spreadsheet features within the plan file, within the limits of the sheet protections applied to the
plan file. Additionally, special Axiom Software features are available on the Axiom tab.

Plan files can have multiple sheets. For example, a plan file might have an Instructions sheet, a Budget
sheet, and a Payroll sheet. Plan files are designed to meet your organization's particular planning needs,
and vary from system to system. If you have any questions about the contents of a plan file, contact
your system administrator.

Calc method libraries

Each sheet in your plan file may have access to a calc method library. Calc method libraries contain sets
of predefined rows that define the formatting and calculations for rows in your plan. You can use these
calc method libraries to insert new rows into your plan, or to change the calculations used on existing
rows of your plan. See Adding or changing rows in a plan file.

Plan file access

You have been granted rights to access certain file groups and certain plan files within those file groups.
Using the file group buttons on the Axiom tab or the file group treeview in the Explorer task pane, you
can open those plan files according to the level of access you have been assigned in Security (for
example, read-only or read/write). Your organization may also provide customized ways of accessing
these file groups and plan files.

Plan files can also be part of a plan file process or a workflow. In this case the planning cycle has a defined
set of stages (or steps), and each plan file has a designated owner for each stage. If you are assigned as
an owner, this means it is your responsibility to complete the current "task" in the process or the
workflow. This may mean editing the plan file or reviewing it, depending on the current stage. Axiom
Software may "elevate" your access rights to the plan file as necessary so that you can complete this
task. For example, if you normally have read-only access to plan files, but you are the assigned owner of
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a plan file in an edit stage, then you will be temporarily granted edit rights so that you can complete the
task.

Opening a plan file
Plan files are accessed from the File Groups group on the Axiom tab, or in the Explorer task pane. Your
security settings determine what file groups you have access to, and which plan files you can access
within the file group. Your access rights to each plan file (read-only or read/write) are determined by a
combination of your security settings and whether you are the current owner of the plan file in an active
plan file process or a workflow.

NOTE: The names of the file groups and how they are presented to you is determined by your
organization. Although the default presentation is on the File Groups group of the Axiom tab, your
organization may decide to customize the group name or location, or present file groups in a custom
ribbon tab or task pane. Plan files may also be accessible via the Process task pane or the Workflow
task pane. Contact your system administrator if you have any questions about how to access your
plan files.

To open a plan file:

1. Onthe Axiom tab, in the File Groups group, click the name of the file group that you want to
work with. The following screenshot shows some example file group buttons:

AXIOM
V= Budget 2017
E Capital Reguests

If you have access to any file group administration features, then clicking on the file group button
will bring up a menu with your options. In this case, you must click Open Plan Files in order to
open a planfile. If you do not have access to any file group administration features, then clicking
on the file group button automatically launches the Open Plan Files dialog.

File groups can be organized into categories. In that case, click the category name to open a sub-
menu with the list of file groups in the category, and then click the desired file group name.

2. Inthe Open Plan Files dialog, select the file or files that you want to open, and then click OK.

This dialog lists all plan files available to you based on your Security settings. If you have
previously opened a plan file within this session, that plan file will be selected by default when you
enter the dialog (unless the dialog displays plan files in groupings, in which case previous
selections are not retained).
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The search box at the top of the dialog can be used to quickly find a particular plan file. The file
group administrator determines which plan file properties are included in this search, but by
default the plan code and description are searchable. You can also sort and filter the list using
standard Axiom grid functionality.

TIP: If you have read/write permissions to a file but you want to open it as read-only to
prevent locking the file from other users, right-click your selection and then select Open Read
Only.

If the dialog is empty, then either you do not have access to any plan files in the file group, or the
plan files have not yet been created for the plan codes that you have rights to.

The selected plan files open. If a file was opened read-only, then the text (R/O) displays in the file tab.
Read-only plan files cannot be saved.

NOTE: If another user has the plan file open with read/write permissions, then the file will be opened
as read-only, regardless of your security permissions.

Ifthe plan file is form-enabled, it opens as a web form within the current client. When using Axiom forms,
the form is always opened as read-only, and any save processes are for saving data to the database only.
The functionality available in an Axiom form is solely dependent on how the form is configured; if you
have any questions about the use and features of a web-enabled form, contact your system
administrator.

Advanced options
The following advanced options in this dialog are generally only available to administrators:

« Ifyou want to open a plan file without refreshing Axiom queries that are configured to refresh on
open, right-click the file and then select Open Without Refresh. Generally, you should only do this
if you are opening the file for troubleshooting purposes or to edit its configuration only.

« Ifno plan files have been created for this file group, and you have rights to create plan files, then a
link appears in the blank plan file list: Create Plan Files for File Group. You can click this link to
open the Create Plan Files dialog.

« Ifyou want to see plan codes that do not yet have a plan file, select Show Plan Files that have
not been created. This is for reference only; you cannot create individual plan files from this
dialog.

o Ifthe plan file is form-enabled and you want to open it as the source spreadsheet file instead of as
the web form, select Open as Spreadsheet. This option is available to all users.

Creating a plan file

Some file groups may be set up so that users can create plan files on demand. Typically this configuration
is used for planning processes where the list of projects or initiatives to be planned for is not known in
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advance, such as capital project planning or strategic planning. Instead of planning based on a
predefined list of items (such as budgeting based on departments), users can create plan files as they are
needed.

NOTE: The ability to create a plan file "on demand" is only available if the file group meets certain
requirements and the feature has been enabled in the file group properties. For more information on
using this feature with a file group, see the File Group Administration Guide. For other file groups,
end users do not create plan files; instead, an administrator creates the plan files using the Create
Plan Files utility.

To create a plan file on demand:
1. Onthe Axiom tab, in the File Group group, click the button for the file group where you want to
create a new plan file.

The Open Plan Files dialog opens.

2. To create the plan file, you can create it based on the plan file template, or you can clone an
existing plan file. Use the commands in the top right-hand corner of the dialog, above the list of
existing plan files:

o To create a new plan file based on the template, click the plus icon .

The name of this command is configurable for the file group. For example, the command
may say "Create plan file," or "Create new project,"” or "Add strategic initiative."

o To clone an existing plan file to create a new plan file, select the plan file that you want to
clone, and then click Clone selected item.

O Open Plan Files ?

. .
I) Open Plan Files for Capital Requests

type here to filter list> + Add New Request ER Clone selected item

CapitallD E Description E Dept |Z| CapRequestCode E Locked By |Z| Last Modified |Z|

4 Mew Machinery 51500 CapReqg51500-4-2016 9/23/2015 1:07:33 PM
5 Equipment Maintenance 44500 CapReqg44500-5-2016 9/23/2015 1:08:06 PM
] Mew Warehouse 43500 CapReg43500-6-2016 9/23/2015 1:08:35 PM

These commands are not available for file groups where the on-demand feature has not been
enabled.

3. Before the plan file is created, you may be prompted to select certain values relating to your new
plan file, such as specifying a department. Complete the inputs as appropriate and then click OK.

The new plan file is created, and opens in Axiom Software. You can now complete any necessary inputs
and changes, and then click Save to save it.

If you cloned an existing plan file, any inputs in the existing plan file are also included in the new file. You
may need to change these entries as appropriate for the new file.
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NOTES:

« Ifyou do not have the necessary security permissions to create new plan files in an on-
demand file group, then the options to "create new" or "clone existing" do not display in the
dialog.

« The "clone existing" feature can be disabled at the file group level; in which case the option
does not display in the dialog.

Editing a plan file

When you open a plan file, the level of edit rights depends on the combination of your security settings
and whether you are the current owner of the plan file in an active plan file process or a workflow. For
example, you may normally have read-only access to the plan file, but when you are the step owner for
an Edit Plan File task in a plan file process, you are temporarily granted read/write access.

If you have edit rights to a plan file, note the following:

« Plan files are typically designed so that editable cells are shaded or otherwise marked as available
for edit. If a cell is editable, you can input values directly, or use Excel formulas to result in a value.
All other areas of the sheet are typically protected and cannot be changed.

o Some cells may use Data Validation to present a list of choices. In this case you can use the drop-
down list to select your desired choice.

o Depending on your security rights, you may be able to add new rows to the plan, or change the
calculations used on existing rows. For more information, see Adding or changing rows in a plan
file.

o Ifyour plan files support it, you may be able to double-click on a row of the plan to bring up an
input form for that row. The input form contains key settings for the row that you can change.

Plan file design is completely flexible and is set up to meet the needs of your organization. If you have
any questions about the design of your plan files, contact your Axiom Software system administrator.

When you have finished making edits to the plan file, you can click Save to save the changes and to save
your data to the database. For more information, see Saving a plan file.

Adding or changing rows in a plan file

Calc method libraries store sets of predefined calculation methods that define the formatting and
formulas for rows in your plan file. You can use calc methods to:

o Add a new row (or rows) to your plan.

When plan files are created, they may only be populated with accounts that have historical data.
You may need to use calc methods to add an account to your plan if you did not plan for that

User Guide Axiom Software | 35



account last year. You can also use calc methods to add new items to your plan, such as new
employees or new capital items.

« Change the calculations used in an existing row in your plan.

Using the calc method "change" option, you can change the calculations used on existing rows of
your plan by applying a different calc method to that row. For example, imagine that the default
calculation for an account is to spread a total amount evenly across months, but for your plan
code it would be more appropriate to use a monthly statistic to spread the total.

Calc methods can be used even when the sheet is protected.

Adding rows to a plan file
You can insert new rows into your plan file using calc methods. A calc method is a predefined row (or
rows) that defines the formatting and formulas to be applied to a row. For example, you may need to:
o Add an account that is not currently in the plan file
o Add anewemployee

o Add additional detail lines, if you are planning for certain accounts at the detail level

After a calc method is inserted, you need to complete the new row(s) with the appropriate information.
For example, you may need to enter an account number, or input plan values. The calc method may use
a form to help you complete some of these inputs.

You can only insert calc methods if you have the appropriate security permissions. The ability to insert
calc methods is controlled on a per file group basis, using the Allow Calc Method Insert permission.
Additionally, administrators and users with the Manage Calc Methods permission can always insert calc
methods.

Additionally, most plan files are set up to use calc method controls. If you have the necessary security
permissions to insert calc methods, then these controls further specify where calc methods can be
inserted, and which calc methods can be used at each location.

There are several different ways to add a new row to a plan file. The methods available to you depend on
how your plan files have been set up by your administrator:

o You can use custom insertion points to automatically add new rows to the appropriate locations
throughout the plan file.

e You can double-click on designated rows within a sheet to add new rows at that location.

o Ifthe plan file does not use either of the above methods, or if you are a calc method administrator
who can add rows anywhere in the file, then you can add new rows manually.

Adding a row using a custom insertion point

Plan files may be set up with custom insertion points. These points are intended to guide you to the
appropriate places to add new rows to a plan file. Custom insertion points are available on the Add Row
(s) > Custom Inserts menu.
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There are two different types of custom insertion points: dynamic and static. Plan files may use only
dynamic insertion points, only static insertion points, or a combination of both.

o When using a dynamic insertion point, you select the item that you want to add to the plan file
(such as an account), and then the insertion controls dynamically determine where the account
should be added. If the account already exists in the file, you are taken to the relevant row.

o When using a static insertion point, you select from one or more specific areas in the plan file that
are enabled for insertion, and then add the new row in that selected location.

The Custom Inserts menu shows all insertion points defined within the file (not just for the active sheet).
When you select an insertion point, you may be taken to another sheet in the file.

The Custom Inserts menu is only available if you have the appropriate security permissions to insert calc
methods.

To insert new rows using a custom insertion point:

1. Onthe Axiom tab, in the File Options group, click Add Row(s). Then, select the desired insertion
point from the Custom Inserts menu.

TIP: You can also access this menu by right-clicking anywhere in a plan file (Calc Methods >
Custom Insert).

Dynamic insertion points are single items on the menu. For example, there might be a dynamic
insertion point named Update an account:

5= Add Row(s) ~

Custom Inserts
|_'] Update an account

Static insertion points are organized into sub-menus. For example, there might be sub-menu
named Add a new employee, which contains two insertion points: Hourly and Salary.

5= Add Row(s) -
Custom Inserts

|||_| Add a new employee F Add a new employee actions on sheet Payroll |
|||_| Add a non-wage account k |_'] Hourly

|_'] Salany

2. The next step depends on whether you have selected a dynamic insertion point or a static
insertion point:

o Ifyou have selected a dynamicinsertion point, the Choose Value dialog opens. Select the
desired item that you want to add to the plan file, and then click OK. For example, the

dialog may display a list of accounts, in which case you would select the account that you
want to add.
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If the selected item already exists in the relevant sheet and no further calc methods can be
inserted for it, then you are simply taken to the location of the existing item. The dynamic
insertion process is now complete. Otherwise, the dynamic insertion process determines
where the selected item can be added, and moves your cursor to that location.

o Ifyou have selected a static insertion point, your cursor is moved to the location that
corresponds with the selected insertion point.

3. One of the following occurs, depending on whether multiple calc methods are eligible to be
inserted at this location:

« Multiple calc methods: If more than one calc method can be inserted at this location, then
the Insert Calc Method dialog opens. Select the calc method that you want to insert, and
then click OK.

€ Insert Calc Method(s) in sheet Budget ?

Available Calc Methods: Details:

Detail MName Edit Months
Edit Months Group Usar
Fixed

Rows 1

Description |Use this calc method when you need to edit the
values for each individual month in the plan.

Number of items to insert: |1

0K | | Cancel

Example Insert Calc Method dialog

The available calc methods are listed in the left-hand side of the dialog. When you select a
calc method name, the properties of that calc method display in the right-hand side of the
dialog, including a description. If you are not sure which calc method to use, the
descriptions may provide guidance.

If you want to insert multiple instances of the calc method, edit the Number of items to
insert. By default, this is set to 1. For example, you may need to add two new employees to
a payroll budget, and both employees use the same calc method. In this case you can set
Number of items to insert to 2. The number of items that you can insert at any one time
may be limited to a certain maximum amount.
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NOTE: The calc methods in this list are always limited to the calc methods allowed at
this location. If you are an administrator or a user with the Manage Calc Methods
permission, and you want to insert a different calc method at this location, you must
insert it manually.

o Single calc method: If only one calc method can be inserted at this location, then that calc
method is selected automatically, and the Insert Calc Method dialog does not display.

If this location is configured to allow you to insert multiple instances of the calc method,
then you are prompted to specify the number of items to insert. Enter the number of items
(up to the specified maximum) and then click OK.

€ Insert "

Enter the number of items to insert.

2

Ok | | Cancel

4. Ifthe selected calc method has defined variables, then the Calc Method Variables dialog displays.
Enter values for the variables, and then click OK.

The values that you enter for the variables will be placed in the appropriate cells when the calc
method is inserted into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, this dialog does not
display and the calc method is simply inserted into the sheet.

NOTES:

« Ifyour plan files have been configured to support double-click forms, you can open this
form again later by double-clicking the calc method in the sheet. You can then change
any entries as needed. Keep in mind that some variables may be set up so that they
only display when inserting, such as the variable for selecting an account.

« Ifyou areinserting multiple instances of the calc method, the selected values will be
repeated in each inserted calc method. Most likely you will need to edit the calc
methods after they are inserted to select unique values for each item.

After the calc method is inserted into the sheet, you may have inputs to complete. For example, you may
need to input an annual total to be spread equally across months or according to a statistic.

Adding a row by double-clicking

Plan files can be set up to allow adding new rows by double-clicking in designated locations. These
locations will be designated in the sheet using text such as: "Add new row here" or "Double-click to add a
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new account." The specific text used and how it appears depends on your particular implementation.

& Home 7= [BGT17] 41500

|1.f11s j|

41500 New York Warehouse

Current View: Standard view

Account

Overhead

5600 Rent Expense

7200 Catering

G700 Telephone

&500 Freight

G900 Supplies

9200 Depreciation and Amortization

<= Dauble-click 1o add naw accaunt ==

Total Overhead

Example plan file with a double-click "hotspot" for adding rows

To add a new row by double-clicking:
1. Double-click on the cell which contains the insertion text.

2. One of the following occurs, depending on whether more than one calc method can be inserted at
this location:
o Multiple calc methods: If more than one calc method can be inserted at this location, then
the Insert Calc Method dialog opens. Select the calc method that you want to insert, and
then click OK.
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User Guide

(2} Insert Calc Method(s) in sheet Budget ?

Available Calc Methods: Details:

Detail MName Edit Months
Edit Months Group User
Fixed

Rows 1

Description |Use this calc method when you need to edit the
values for each individual month in the plan.

Mumber of items to insert: |1

OK | | Cancel

Example Insert Calc Method dialog

The available calc methods are listed in the left-hand side of the dialog. When you select a
calc method name, the properties of that calc method display in the right-hand side of the
dialog, including a description. If you are not sure which calc method to use, the
descriptions may provide guidance.

If you want to insert multiple instances of the calc method, edit the Number of items to
insert. By default, this is set to 1. For example, you may need to add two new employees to
a payroll budget, and both employees use the same calc method. In this case you can set
Number of items to insert to 2. The number of items that you can insert at any one time
may be limited to a certain maximum amount.

NOTE: The calc methods in this list are always limited to the calc methods allowed at
this location. If you are an administrator or a user with the Manage Calc Methods
permission, and you want to insert a different calc method at this location, you must
insert it manually using the Add Row(s) menu.
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o Single calc method: If only one calc method can be inserted at this location, then that calc
method is selected automatically, and the Insert Calc Method dialog does not display.

If this location is configured to allow you to insert multiple instances of the calc method,
then you are prompted to specify the number of items to insert. Enter the number of items
(up to the specified maximum) and then click OK.

€ Insert "

Enter the number of items to insert.

2

Ok | | Cancel

3. Ifthe selected calc method has defined variables, then the Calc Method Variables dialog displays.
Enter values for the variables, and then click OK.

The values that you enter for the variables will be placed in the appropriate cells when the calc
method is inserted into the sheet.

For example, the calc method may have a variable for Account. The account that you select in this
dialog will be placed in the account column when the calc method is inserted into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, this dialog does not
display and the calc method is simply inserted into the sheet.

NOTES:

« Ifyour plan files have been configured to support double-click forms, you can open this
form again later by double-clicking the calc method in the sheet. You can then change
any entries as needed. Keep in mind that some variables may be set up so that they
only display when inserting, such as the variable for selecting an account.

« Ifyou areinserting multiple instances of the calc method, the selected values will be
repeated in each inserted calc method. Most likely you will need to edit the calc
methods after they are inserted to select unique values for each item.

After the calc method is inserted into the sheet, you may have inputs to complete. For example, you may
need to input an annual total to be spread equally across months or according to a statistic.

Adding a row manually

You can add new rows to a plan file manually by placing your cursor in the desired area of the sheet and
then using Add Row(s) > Insert Calc Method(s).
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This command is only available if you have the appropriate security permissions to insert calc methods. If
you have the appropriate permissions, then the availability of the command further depends on the
usage of calc method controls in the sheet:

o If calc method controls are used in a sheet, then this option is only available for rows that are
enabled to allow calc method insertion. In almost all cases, these are the same rows that are set
up with custom insertion points, so it is easiest to use the custom inserts menu to be taken
directly to these enabled areas.

o If calc method controls are not used in a sheet, then you can insert calc methods anywhere in the
sheet.

Also, if no calc methods have been defined for a sheet, then this command is not available because there
are no calc methods that can be inserted.

Administrators and users with the Manage Calc Methods permission can insert calc methods manually
anywhere in the sheet, regardless of whether calc method controls are being used.

To insert a row manually:

1. Placeyour cursor in the row directly below where you want the new calc method to be inserted.

NOTE: If you are inserting a calc method on a row that is set up with calc method controls, the
location of the insert may be determined by the controls. By default, calc methods are
inserted above the current row, but the calc method controls may be configured to insert
below the current row.

2. Onthe Axiom tab, in the File Options group, click Add Row(s) > Insert Calc Method(s).
If this menu item is not available, then one of the following circumstances applies:

o No calc methods have been defined for the current sheet.
o Calc method controls are being used, and the current row is not enabled for insertion.

o You do not have security permissions to insert calc methods.

3. Inthelnsert Calc Method dialog, select the calc method that you want to insert, and then click
OK.

The available calc methods are listed in the left-hand side of the dialog. When you select a calc
method name, the properties of that calc method display in the right-hand side of the dialog,
including a description. If you are not sure which calc method to use, the descriptions may
provide guidance.

If you want to insert multiple instances of the calc method, edit the Number of items to insert. By
default, this is set to 1. For example, you may need to add two new employees to a payroll
budget, and both employees use the same calc method. In this case you can set Number of items
to insertto 2.
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NOTES:

o Ifcalc method controls are being used, then the list of calc methods is limited to those
allowed by the insertion point. Calc method administrators always see all calc methods
when manually inserting a calc method.

« Ifthe selected calc method uses variables, and you do not want to be prompted to
enter variable values, you can clear the Prompt for calc method variables check box.
This option only displays on the dialog if the selected calc method uses variables, and if
the user is an administrator or has the Manage Calc Method permission.

4. Ifapplicable, in the Calc Method Variables dialog, enter values for the calc method variables, and
then click OK.

If the calc method has variables, then the values you enter for the variables will be placed in the
appropriate cells when the calc method is inserted into the sheet.

For example, the calc method may have a variable for Account. The account that you select in this
dialog will be placed in the account column when the calc method is inserted into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, this dialog does not
display and the calc method is simply inserted into the sheet.

NOTE: If your plan files have been configured to support double-click forms, you can open this
form again later by double-clicking the calc method in the sheet. You can then change any
entries as needed. Keep in mind that some variables may be set up so that they only display
when inserting, such as the variable for selecting an account.

After the calc method is inserted into the sheet, you may have inputs to complete. For example, you may
need to input an annual total to be spread equally across months or according to a statistic.

Changing rows in a plan file

You can change the calculations used on an existing row in a plan file, by overwriting it with a new calc
method. You can also use the change feature on multiple-row calc methods.

For example, your plan may have a row that requires monthly entries to calculate an annual total, and
you want to change the calculation to instead require a single annual entry that is spread evenly across
months.

The change operation does not simply replace the existing row. Certain information in the row may be
retained, such as the account number and historical data, depending on how the new calc method has
been configured, and whether calc method forms are used. For information on how the change
operation replaces the existing row, see Change calc method rules.

You can only change calc methods if you have the appropriate security permissions. The ability to change
calc methods is controlled on a per file group basis, using the Allow Calc Method Change permission.
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Additionally, administrators and users with the Manage Calc Methods permission can always change
calc methods.

Additionally, most plan files are set up to use calc method controls. These controls specify which rows
can be overwritten, and which calc methods can be used at each location.

To change a row in a plan file:

1. Place your cursor anywhere in the row (or rows) that you want to change by applying a new calc
method.

If the original calc method in the sheet is a multiple-row calc method, it does not matter where
you place your cursor, as long as it in within one of the rows of the calc method.

( N\
IMPORTANT: This procedure assumes that your system has enabled template validation. Use

of template validation allows Axiom Software to detect specific calc methods in the sheet,
based on system-generated codes. If your system is not using template validation, then you
must highlight all rows of the multiple-row calc method before you can change it. If you are
not sure whether your system uses template validation, please contact your system

administrator.
\_ J

2. Onthe Axiom tab, in the File Options group, click Add Row(s) > Change Calc Method.

If calc method controls are used in the sheet, then this command is only available if the first row of
the selection is enabled for overwriting. If calc method controls are not used in the sheet, then
you can change any rows.

Administrators and users with the Manage Calc Methods permission can always change calc
methods anywhere, regardless of calc method controls.

NOTE: If only one calc method is allowed for changing the row at this location, then the menu
command is changed to Replace with CalcMethodName. When you select this command,
the listed calc method is automatically used for the change operation, and the Change Calc
Method dialog does not open.

3. Inthe Change Calc Method dialog, select the calc method that you want to use to replace the
selected row or rows, and then click OK.

The available calc methods are listed in the left-hand side of the dialog. When you select a calc
method name, the properties of that calc method display in the right-hand side of the dialog,
including a description. If you are not sure which calc method to use, the descriptions may
provide guidance.
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NOTES:

o Thelist of calc methods is limited to the allowed calc methods for this location (if
applicable). If you are an administrator or a user with the Manage Calc Methods
permission, then all calc methods are listed.

« Ifyou have selected a calc method with a different number of rows than the original calc
method, Axiom Software informs you of the row difference and asks you to confirm
that you want to continue. The sheet will be adjusted accordingly for the additional or
fewer rows.

4. Ifapplicable, in the Calc Method Variables dialog, enter values for the calc method variables, and
then click OK.

If the calc method has variables, then the values you enter for the variables will be inserted in the
appropriate cells when the calc method is placed into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, this dialog does not
display and the change operation continues.

Calc method variables are an exception to the normal calc method changing rules. If you enter a
value for a variable, that value is always placed into the sheet when the calc method is changed.
However, if you leave a variable value blank, then the normal change rules apply. Additionally,
some calc method variables are set up so that they are only displayed when the calc method is
inserted, such as a variable for selecting an account.

NOTE: If your plan files have been configured to support double-click forms, you can open this
form again later by double-clicking the calc method in the sheet. You can then change entries
as needed.

The selected calc method replaces the selected row or rows.

Multiple-row calc methods and changing rows

You can replace single-row calc methods with multiple-row calc methods, and vice versa. The change
operation intelligently deletes rows and inserts rows, depending on the row difference between the
original calc method and the new calc method.
o Ifthe new calc method has fewer rows than the original calc method, the additional rows in the
sheet are deleted.
o Ifthe new calc method has more rows than the original calc method, additional rows are inserted
into the sheet.

For example, if you want to replace a single-row calc method with a five-row calc method, place your
cursor in the row with the existing single-row calc method. The change operation replaces the single row
with the first row of the five-row calc method, and then inserts four new rows to accommodate the rest
of the five-row calc method.

User Guide Axiom Software | 46



If you want to replace a five-row calc method with a three-row calc method, place your cursor anywhere
in the existing five-row calc method. The change operation replaces the first three rows of the five-row
calc method with the new calc method, and then deletes the extra two rows in the sheet.

4 N\
IMPORTANT: This procedure assumes that your system has enabled template validation. Use of

template validation allows Axiom Software to detect specific calc methods in the sheet, based on
system-generated codes. If your system is not using template validation, then you must highlight all
rows of the multiple-row calc method before you can change it. In the previous example, you would
need to manually highlight all five rows of the calc method within the sheet before changing it,
because Axiom Software would be unable to automatically detect the starting and ending rows.

Change calc method rules

End users can replace an existing calc method in the sheet by applying a new calc method, thereby
changing the calculations used on the row (or rows).

The following replacement rules apply when using the Change Calc Method feature. When creating calc
methods, keep these rules in mind so that change operations will work as desired.

The change operation is evaluated on a cell by cell basis. Actions depend on what the new calc method
(the calc method replacing the existing calc method) contains in each cell.

If the new calc The following action occurs:

method

contains:

Avalueora The value or string in the new calc method is ignored, and the existing cell value
string is retained as follows:

o Ifthe existing calc method contains a value, a string, or is blank, then the
existing cell contents are retained as is.

« Ifthe existing calc method contains a formula, the value resulting from the
formula is retained by using Paste Special — Values. The formula is removed.

Formula The formula in the new calc method overrides the existing cell contents.

Empty cell The empty cell in the new calc method overrides the existing cell contents.

NOTE: The normal change rules do not apply to calc method variables. If the new calc method has a
variable defined, the variable value specified by the user always overrides the existing cell contents.
However, if the user does not specify a variable value (if the variable is not required and the user
leaves the entry blank, or if the variable is excluded from the change operation because it is set to
Insert Only), then the normal change rules apply to that cell.
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Adding sheets to an Axiom file

If your plan files, reports, or utilities have been designed to allow adding new sheets, then you can add
these sheets using the Add New Sheet feature. The new sheet will be created by copying a designated
master sheet, which serves as the sheet "template." If the file has multiple master sheets, you will be able
to choose the master sheet to copy.

The Add New Sheet feature is only available if the file has one or more designated master sheets. These
master sheets must be set up and enabled by the file designer.

NOTE: If workbook protection is not applied to the file (or if you have permission to remove it), then
you can also add new sheets using normal spreadsheet features. However, if workbook protection is
applied to the file, then the Add New Sheet feature is the only way to add new sheets.

To add a new sheet to an Axiom file:
1. Onthe Axiom tab, in the File Options group, click Add New Sheet.

2. Inthe Add New Sheet dialog, complete the following:

o New sheet name: Type the name of the new sheet. This name cannot be the same as any
other sheet in the workbook, including the master sheets. It is recommended to avoid
spaces and special characters in the name.

o Create from master sheet: Select the master sheet to copy in order to create the new
sheet.

€ Add New Sheet H

Add a new shest to the file, based on a master shest,

Mew sheet name:

Mewbdachine
Create from master sheet:

Proposal

Request

QK | | Cancel

3. Click OK to create the new sheet.
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The new sheet is placed in the workbook as follows:

« Ifthe workbook already contains copies of the selected master sheet, then the new sheet is placed
after (to the right of) the most recently added copy.

o Ifthe workbook does not already contain a copy of the selected master sheet, then the new sheet
is placed after the master sheet if it is visible. If the master sheet is not visible, then the copy is
placed after the last visible sheet in the workbook.

NOTE: Added sheets cannot be printed using the Print Plan Files utility. If you need to print an
added sheet, you must do it by using Print within the file.

Viewing and managing file attachments for a plan file

Some file groups support the ability to attach supporting files to individual plan files. For example, in a
capital planning process, you may want to attach various supporting information about the capital
request, and have that information easily reviewable along with the plan file itself.

NOTE: This topic explains how end users can view and manage file attachments for their plan files. If
you are an administrator and want to learn more about enabling this feature for file groups and
managing it at the file group level, see the File Group Administration Guide.

If you have read/write access to a plan file, then you can add and delete attachments as well as view
attachments. If you have read-only access to a plan file, then you can only view existing attachments.

To access the file attachments for a plan file:
1. Open the plan file.

2. Onthe Axiom tab, in the File Options group, click File Attachments.

One of two dialogs will open, depending on your level of rights to the plan file: the Browse Attachments
dialog to view existing attachments, or the Manage Attachments dialog for full attachment rights.

Browsing file attachments

The Browse Attachments dialog lists all current file attachments for the plan file. To open an attachment,
select the file in the list and click Open (or you can double-click the file).

How the attachment opens depends on the type of attachment. Excel-compatible files will open directly
in the current Axiom Software session, in a new tab. Other file types will open in their native application—
such as Word for a DOCX file, or Adobe Reader for a PDF file—assuming that application is present on
your computer.
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Managing file attachments
Using the Manage Attachments dialog, you can add, delete, and view attachments for a plan file.

o Adding a file attachment: Click Upload Attachment, and then navigate to the file that you want
to add as an attachment. The file will be imported into the Axiom Software database and
associated with the plan file.

o Deleting a file attachment: Select the file that you want to delete, and then click Delete. The file is
deleted from the Axiom Software database and will no longer be available as an attachment.

+ Renaming a file attachment: To rename a file attachment, right-click the attachment and then
click Rename. The name becomes editable and you can type your changes.

o Editing the attachment description: To define or edit the description for the file attachment,
select the file and then click Edit Description.

o Opening a file attachment: Select the file that you want to open, and then click Open (or you can
double-click the file).

If the attachment is an Excel-compatible file that opens within the Axiom Software session, it will open
with read/write access. You can edit the file and save changes if desired.

If the attachment is a Word file or a PowerPoint file, then it opens in its native program with read/write
access if the corresponding Axiom Software add-in is already installed (or if it is successfully installed
when the file is opened). You can edit the file and save changes by using the add-in.

If the Word or PowerPoint add-in is not installed, or if the file is some other file type, then you cannot
edit and save the file directly. If you need to edit one of these files, you should save a copy of the file
locally and make your edits. You can then delete the existing file attachment in the Axiom Software
database, and upload your edited copy.

Saving a plan file

When you save a plan file, the following occurs:
o Theplan file is updated in the Axiom Software file system.
o Data from the file is saved to the Axiom Software database.

To save a plan file:

o Onthe Axiom tab, in the File Options group, click Save.

Before saving data to the database, Axiom Software performs an Excel calculation to update all formulas
in the sheet (including any Axiom functions), and validates the file. If errors are found, the file is still saved
but the data save is stopped and errors are displayed in the Save Errors pane. These errors must be
corrected before data can be saved to the database.
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If no errors are found, then the file and data are saved and a confirmation message displays. The
confirmation message includes information about the number of records saved (click Show Details to
see this information if desired).

NOTES:

o Your file group security permissions determine whether you can save a plan file and/or save
data to the database.

o Ifthe planfileis part of a plan file process or a workflow, then your ability to save the plan file
may depend on whether you are the current task owner of the plan file. Also, if you are the
current task owner, then you may be prompted to complete your active task as part of the
save process.

« The save-to-database process only occurs if the file is configured to save data to the database.
However, most plan files are configured to save to the database.

If the plan file is open as read-only, then it cannot be saved. Exception: some implementations may use a
combination of read-only and save data permissions, where the plan file is a static input form and only
data is saved to the database.

Additional save options

When you click the Save button, Axiom Software automatically performs all save actions that your user
rights allow and that the file is configured to perform. This is the default save behavior that should be
used in the majority of cases. If necessary, you can use additional save options to only save the plan file,
or to only save the data.

For example, you may be in the process of inputting planning data into the file, and you don't want to
save the data to the database until you have finished all your inputs. You can save just the plan file while
you are working, and then when you are finished, perform a normal save.

IMPORTANT: If you save a plan file without performing a save-to-database (or vice versa), this may
cause a mismatch between the data in the file and the data in the database. Ideally, the plan file save
and the save-to-database should occur together, so that the database and plan files remain in synch,
and so that you can always track how a plan value was calculated.

To save only the file:

o Inthe Axiom tab, in the File Options group, click the down arrow to the right of the Save button,
and then click Save File Only.

The plan file is saved. All save-to-database processes are ignored.

To save only the data:

« Inthe Axiom tab, in the File Options group, click the down arrow to the right of the Save button,
and then click Save Data Only.

Data from the file is saved to the database. The file itself is not saved.
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Saving a copy of a plan file

If you want to save a copy of a plan file for archive purposes, or to provide a copy to a non-Axiom
Software user, the best approach is to take a snapshot of the plan file. The snapshot process converts
the file to a regular Microsoft Excel file that can be used outside of Axiom Software. Keep in mind that
Axiom formulas will be converted to values, so in some cases you may not be able to tell exactly how a
plan value was calculated. For more information, see Taking a snapshot copy of an Axiom file.

Although the Save As (Local) option is available for plan files, generally it should not be used to save
copies of plan files. Once a copy of a plan file is saved outside of its file group, the plan file becomes
disconnected from the file group and certain functionality will be lost. End users do not have a way to
"restore" the copy to the file group. Save As cannot be used to create plan file "versions."

Completing plan file tasks

Plan files in a file group can be part of a defined planning process, which is a set of steps for plan files to
progress through during a planning cycle. For example, you may have a basic process with two stages:
one for managers to develop the plans, and one for the Finance department to review and approve
them. Or you may have a multi-step plan which includes several passes of plan development, and
multiple levels of review.

For each defined step of the process, each plan file has a designated owner. When the plan file is in a
step, that owner has a plan file "task" to perform one of the following actions:

o Edit the plan file and then submit it to the next step.
OR
o Review the plan file and then approve it or reject it.

The process management feature is the primary means of defining this type of planning process for plan
files. However, some organizations may be still be using the legacy workflow feature. Regardless of which
feature is used, if you are a plan file owner then you will be assigned a task and you will see that task in
the appropriate task pane (either the Process task pane or the Workflow task pane). You may also be
notified of the task via email.

If you are assigned a plan file task, it is your responsibility to complete the task by the specified due date.
You can open the plan file from the appropriate task pane (or using the normal file group menus) and
perform the necessary edits or review. When you are finished, you can complete the task from the
appropriate task pane. You may also have the option of completing the task as part of saving the file.
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NOTE: Process management or workflow may "elevate" your permissions to the plan file as
necessary so that you can complete the current task. For example, under normal circumstances you
might have read-only access to a particular plan file. But if you are assigned a task that requires you
to edit a plan file, then process management or workflow will elevate your permissions as needed so
that you can edit the file and save its data. Once you have completed the task, your permissions will
return to normal levels.

Completing a task in a plan file process

If you have an assigned task in a plan file process, the task displays in the Process task pane. You can
review your assigned tasks and open the associated plan files using this task pane.

< Axiom Assistant

Current Processes Ef:‘
@ | Showing my processes only Show all processes
=3
|| - fd. Budget Process View status
[ You have 2 active tasks in this process
=8 IO CES ST e
2 || &a Management Approval Show process view

Process Actions = Cpen...

Dept 44000 (California Administrati... Du g
Dept 44500 (California Warehouse)  Due on 8/0

m
Q
0

m
oh &h

Assistant
(=]

Example Process task pane with active tasks

When you have finished editing or reviewing a plan file for which you are the currently assigned owner,
you must complete the associated process task. You can complete this task using the Process task pane,
or as part of saving the plan file.

Completing a plan file task using the Process task pane
You can complete your current process tasks using the Process task pane.

1. Onthe active step in the Process task pane, click one of the following actions (depending on the
step type):
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o For edit steps, click Mark step as complete. This moves the plan file to the next step.

o Forapproval steps, click Process Actions > Approve if you approve the plan file and want
to move it to the next step. Click Process Actions > Reject if the plan file needs more work,
and you want to return it back to the prior step.

NOTE: Some plan file processes may have an additional action of Deny request (or a
similar customized name). The deny action causes the plan file to be aborted in the
process, so that it no longer progresses in the process. This action is intended for cases
where the plan file should be completely removed from the process and never
approved.

If you currently have more than one active plan file in a step, you can select a plan file before
clicking the appropriate action, and that plan file will be pre-selected for completion in the Process
Action dialog. You can also right-click a plan file to perform any of these actions.

2. Inthe Process Action dialog, do the following:

o Ifyou currently have multiple active plan file tasks for this step, select the check boxes for
the plan file tasks that you want to complete right now. If you only have one active plan file
task (or if a plan file was selected in Process task pane before clicking the action), then that
plan file is selected automatically and no check boxes display.

o You can optionally enter a comment to be stored in the process history and included in the
email to the next stage owner (if notifications are enabled).

O Process Action u

|-O} Mark process step as completed in process 'Budget Process'.

Current Step MNext Step
D‘ Initial Submission = Management Approval
3. Jane Doe .:. Rufus Xavier Sasparilla
Complete step for: (1 of 2 selected) Select All Clear All

[] Dept 40000 (Los Angeles - Store 34)
Dept 40500 (West Coast Distribution)

Comment: Any comment will be stored with the process and included in notifications to the next step owner,

This is a comment about the budget.

OK | | Cancel

Example action dialog for multiple active tasks

3. Click OK to complete the task.
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Once the background tasks are complete and the plan file has been moved to the next (or prior) step,
then you are no longer the step owner and the task no longer displays as active in the task pane.

Completing a plan file task when saving a plan file

Your system may be configured so that when you save a plan file for which you have an active process
task, you are given the option to complete the task after the save occurs.

NOTES:

« The option to complete a plan file task while saving is only available if the plan file is in a step
that allows edits. If the plan file is in an approval step that does not allow edits, then you must
use the Process task pane to complete the task.

« This option only applies to spreadsheet plan files. If you are working on a form-enabled plan
file, there is no way to prompt the user to complete the task as part of a save. Instead, the
plan file may contain a button that allows you to complete the current task.

If the save is successful, a dialog similar to the following opens:

O Process Action “

rog Perform process action for ‘Budget Process

Previous Step Current Step Next Step

D‘ Initial Submission _: Management Approval Final Approval

& EobJoe & Wendy Hunter (multiple step owners)

) Return to previous step (®) Leave in current step () Advance to next step
Mo action will be taken for Dept 44000 (California Administration).
Comment: Any comment will be stored with the process and included in notifications to the next step owner.

OK | | Cancel

This dialog provides information about the current step for the plan file, as well as the next step and the
prior step (if applicable). Using this dialog, you can select one of the following options:

o Leave in current step (default): You will remain the plan file owner and you can continue to work
on the plan file.

o Advance to next step: Select this option if you are done working on the plan file and you are
ready to advance it to the next step. In most cases this means that you will no longer be the plan
file owner and you can no longer edit the plan file.

« Return to previous step: Select this option if you want to "reject" the plan file and return it to the
previous step. This option is only available if the current step is an approval step. In most cases
this means that you will no longer be the plan file owner and you can no longer edit the plan file.
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Some plan file processes may have an additional action of Deny request (or a similar customized name).
The deny action causes the plan file to be aborted in the process, so that it no longer progresses in the
process. This action is intended for cases where the plan file should be completely removed from the
process and never approved. For example:

Process Action “

foof Perform process action for 'Capital Reguests'

I =

Previous Step Current Step MNext Step

D‘ Initial Submission 0= Manager Approval Multiple Approvals Step
& Wendy Hunter & Wendy Hunter (multiple step owners)
L A i
() Return to previous step () Leave in current step ) Advance to next step

(®) Deny request

The plan file process will be aborted for CapReq 4 (Equipment maintenance).
Comment: Any comment will be stored with the process and included in any notifications.

Mo budget available for this request.

| OK | | Cancel

If you choose any action other than leaving the plan file in the current step, then you can enter an
optional comment to be saved in the process history and included in the notification to the next step
owner (if notifications are enabled).

This process dialog only displays if your system has been configured to prompt users about process
tasks when saving. Otherwise, you must use the Process task pane to complete plan file tasks.

Completing a plan file task for workflow

The Workflow task pane displays when you have an assigned plan file task in workflow. You can review
your assigned tasks and open the associated plan files using this task pane.
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Workflow Tasks ~
Active Plan Files: (4) ¥

+ [Z|Budget Workflow 2013 (4)
(W] 25000 (Finance)
@ETDEHJ (Human Resources)
W] 28000 (Facilities)
(Eh)29000 (Legal)

[N T R, R |

Selected Plan Files: 1
|Open| Submit |

Example Workflow task pane with active tasks

When you have finished editing or reviewing a plan file for which you are the currently assigned owner,
you must complete the associated workflow task. You can complete this task using the Workflow task
pane, or as part of saving the plan file.

Completing a plan file task using the Workflow task pane
You can complete your current workflow tasks using the Workflow task pane.
1. Select the plan file in the Workflow pane, and then click one of the following action buttons
(depending on the stage type):
o For edit stages, click Submit. This moves the plan file to the next stage.

o Forreview stages, click Approve if you approve the plan file and want to move it to the next
stage. Click Reject if the plan file needs more work, and you want to return it back to the
prior stage.

If you selected Submit (or Approve for a review stage with edit rights), the plan file is validated
before the stage change is processed. This is the same validation that occurs when you save a plan
file. If any errors occur, the task completion process is canceled and you must correct the errors
within the plan file before you can complete the workflow task.

NOTES:

o Ifagroupingis used in the workflow, then if desired you can complete the tasks for the
entire grouping instead of for each individual plan file. Select the grouping in the
Workflow pane and then click the action button. Keep in mind that this process may
take some time if there are many plan files in the grouping and/or if the plan files must
be validated as part of the task completion.

« Thevalidation routine can be disabled on a per workflow basis. If disabled, then no
validation will occur before completing the tasks.

Once the validation is complete, the Axiom Workflow Action dialog opens.

2. Inthe Axiom Workflow Action dialog, enter an optional stage comment as desired, and then click
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OK.

The stage comment is included in the email to the next stage owner (if notifications are enabled)
and is also stored within the workflow history.

Axiom Workflow Action [ == |
Sr_‘|_| You are completing a plan file task for DEPT 25000 (Finance).
Workflow Action: Advance
Previous Stage Current Stage Mext Stage
Top Down Targets Initial Submission Final Submission
Ren Swanscn (rswanson) ‘Wendy Hunter (whunter) John Doe (jdoe)
Due: 2/17/2012 Due: 3/2/2012
Stage Comment:
Comment will be stored with the workflow and included in notifications to the next stage owner.
Please review the travel expense budget.
Ok | l Cancel

Example Axiom Workflow Action dialog

Once the background tasks are complete and the plan file has been moved to the next (or prior) stage,
then you are no longer the stage owner and the task no longer appears in the current task list (unless
you are also the owner of the next stage). You can view the completed task in the completed task list.

Completing a workflow task when saving a plan file

Your system may be configured so that when you save a plan file for which you have an active workflow
task, you are given the option to complete the task after the save occurs. If the save is successful, a
dialog similar to the following opens:

Axiom Workflow Action @

SE“_I Perform workflow action for DEPT 25000 (Finance) in 2012 Workflow.

Workflow Action: MNone

Previous Stage Current Stage | Next Stage
Top Down Targets Initial Submission Final Submission
Ron Swanson (rswanson) Wendy Hunter (whunter) John Doe (jdoe)
Due: 2/17/2012 | Due: 3/2/2012
! Return to previous stage @ Leave in current stage _) Advance to next stage

Stage Comment:
Comment will be stored with the workflow and included in notifications to the next stage owner.

Ok ] [ Cancel
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This dialog details information about the current stage of the plan file, as well as the next stage and the
prior stage (if applicable). Using this dialog, you can select one of the following options:

o Leave in current stage (default): You will remain the stage owner and you can continue to work on
the plan file.

o Advance to next stage: Select this option if you are done working on the plan file and you are
ready to advance it to the next stage. In most cases this means that you will no longer be the
stage owner and you can no longer edit the plan file.

o Return to previous stage: Select this option if you want to "reject" the plan file and return it to the
previous stage. This option is only available if the current stage is a review stage. In most cases this
means that you will no longer be the stage owner and you can no longer edit the plan file.

If you choose to move the plan file to the next or previous stage, then you can enter an optional
comment to be saved in the workflow and also included in the notification email to the next stage owner
(if notifications are enabled).

This workflow dialog only displays if your system has been configured to prompt about workflow tasks
when saving. Otherwise, you must use the Workflow task pane to complete plan file tasks.

NOTE: The option to complete a workflow task while saving is only available if the plan file is in a

stage that allows edits. If the plan file is in a review stage that does not allow edits, then you must use
the Workflow task pane to complete the task.
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Using Reports

Axiom Software reports can query data from any table in the Axiom Software database. This section
provides basic information about reports, and explains how to open existing reports and refresh them
with data.

For information on how to set up the data query for a report, and how to configure other Axiom file
options, see the Axiom File Setup Guide.

In addition to the report-specific functionality detailed in this section, you can use standard Axiom file
features and tools. Report files use the same functionality as other Axiom files to perform actions such as
changing views or navigating to file bookmarks. For more information, see Using Axiom File Features and
Printing Files and other File Output Options.

NOTE: As an alternative to spreadsheet reports, you can perform ad hoc analysis on your data using
the Data Explorer. For more information, see Using the Data Explorer.

About reports

Reports use Axiom file functionality to bring in data from the database, and if desired, to save data back
to the database. You can use any Axiom file feature in a report except calc method libraries.

Report files, unlike other Axiom files, are not associated with any file group. You can bring in data from
any table. For example, if you have two file groups that are configured to save data back to two different
tables (or to different columns in the same table), you can use a report to compare the data.

Report structure

Axiom reports are free-format. When you create a new report, you can use various query options to
bring data anywhere into the report, and you can use spreadsheet functionality to format the report and
calculate values such as subtotals and percentages.

Reports can have any number of sheets. Each sheet can be configured to bring in data from the
database, and, if desired, save data back to the database. If you want to use an Axiom query on a sheet,
or save data to the database from a sheet, that sheet must be configured on the Control Sheet. Other
Axiom file functionality, such as Axiom functions or GoTo bookmarks, do not require the sheet to be
configured on the Control Sheet.
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Reports Library

Report files are stored in the Axiom Software database. To make it easy to access and organize reports,
Axiom Software supports a virtual folder structure known as the Reports Library.

Each report is assigned to a folder in the Reports Library. When you open reports, you can navigate
through the Reports Library structure to quickly locate the report that you want to open.

The Reports Library is managed by using Axiom Explorer. If you are an administrator, or if you have
Administer Axiom Explorer rights, then you can use Axiom Explorer to create report folders, move
reports between folders, and delete existing reports. For more information on using Axiom Explorer, see
the System Administration Guide.

You can also save reports outside of the Axiom Software database—for example, to your local computer
or to a network folder. In this case the file is considered to be a non-managed file. It is recommended to
maintain all reports as managed files unless you have a compelling reason to use a non-managed file.

Report output and distribution

In addition to the standard output options for Axiom files—such as the ability to take a snapshot of an
Axiom file—report files can use the File Processing feature.

Using file processing, you can refresh a report file and perform output and distribution actions such as
saving a snapshot copy of the file, emailing a snapshot copy of a file, or exporting data to a CSV/TXT file.
You can process the file "as is," or perform multipass processing on the file, where the file is processed
multiple times using a unique filter for each pass.

For more information, see Processing a report.

Saving data to the database

In addition to viewing data, you can also use reports to calculate data and save data back to the
database. In certain circumstances, it may be more appropriate to use a report to save data rather than
plan files or driver files. If a report file has been configured to save to the database, you can use the Save
button in the File Options group to save data.

Contact your Axiom Software consultant if you are unsure about the best way to manage a certain set of
data.

Opening a report

Axiom Software reports are organized by folder in the Reports Library. The specific report folders and files
that you can access and the level of access rights depend on your security settings. Administrators have
full access to all reports.
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To open a report in the Reports Library:

1. Onthe Axiom tab, in the Reports group, click Reports to bring up the Reports menu.

TIP: You can also open reports from the Explorer task pane or Axiom Explorer.

2. Do one of the following:

o Click All Reports to view all reports within an Axiom grid. You can then select one or more
reports to open. You can sort, filter, and group the list using standard Axiom grid features.
For example, you can find a report by name by filtering on the Document Name field.

o Usethe Reports Library folders at the bottom of the menu to navigate to the specific report
that you want to open. Report folders may have sub-folders.

NOTE: If another user adds a file or a folder to the Reports Library during the current session,
it may not be immediately visible to you. You can refresh your view by selecting Reports >
Refresh File System.

The selected report opens. If a report was opened read-only, then the text (R/0) displays in the file tab.
Read-only reports cannot be saved.

NOTE: If another user has the report open as read/write, then you can only open the file as read-
only, regardless of your security permissions.

Advanced options

o Ifyou want to open areport without refreshing Axiom queries that are configured to refresh on
open, right-click the file and then select Open Without Refresh. This option is only available to
administrators.

o Ifyou have read/write permissions to a report but you want to open it as read-only to prevent
locking the file from other users, right-click the file and then select Open Read Only.

Opening non-managed report files

If you have a non-managed report saved to your local drive or a network folder, you can open it as
follows:

¢ Inthe Excel Client, use standard Excel functionality to open the file within Axiom Software.

¢ Inthe Windows Client, click the Axiom button in the top left-hand corner. Click Open and then
navigate to the file.

Creating a new report

You can create a new report if you have read/write access to at least one folder in the Reports Library.
You can use any of the methods discussed below to create a new report. If you do not have these
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permissions, then the associated menu options for creating new reports will not be available to you.

NOTE: After saving a new report to the Axiom file system, you may not see that new report displayed
in Axiom Explorer or the Reports menu until the file system has been refreshed. You can go to
Reports > Refresh file system to manually trigger a refresh and cause the new report to display.

Creating a new report using the Report Wizard

You can create a new report using the Report Wizard. In the wizard, you make selections regarding the
type of report that you want to create and the desired data, and then the wizard creates a report based
on your choices. You can then further modify the report as needed.

To create a new report using the Report Wizard:
o Onthe Axiom tab, in the Reports group, select Reports > Report Wizard.

For more information on how the Report Wizard works and what types of reports can be made using the
Report Wizard, see the Axiom File Setup Guide.

Creating a new blank report
You can create a new report "from scratch" using the default blank report template. This template is

entirely free-format.

If your organization has saved additional report templates, you can use those to create a new report as
well. Only administrators can create new report templates.

To create a new blank report:
e Onthe Axiom tab, in the Reports group, select Reports > New Report.

If your system has multiple report templates, you can select the template that you want to use
from this menu. Otherwise, the default ReportTemplate is automatically used.

A new report file opens, containing a Control Sheet and one or more blank sheets. Give one of the blank
sheets a name and configure it on the Control Sheet. You can use the Sheet Assistant to do this, or you
can manually type the sheet name into the Control Sheet.

You can now use Axiom file functionality on this sheet, such as using Axiom queries to bring in data. For
more details on setting up Axiom files, see the Axiom File Setup Guide.

Certain features do not require the sheet to be set up on the Control Sheet. For example, if you only
want to use Axiom functions to query data, such as GetData, then you do not have to use the Control
Sheet. However, in most cases you will want to configure used sheets on the Control Sheet.

Saving a new report

To save a new report, click Save in the File Options group of the Axiom tab. When you save the new
report for the first time, you are prompted to define a file name and select a folder location in the
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Reports Library. You can also define a description for the report.

Save As... EI@
Q 7, ? \Axiom\Reports Library\Budget Reports - o
File ~
4 |5 Reports Library . Name Modified Locked By Size Type
I} Budget Reports Drill File Folder
| Forecast Reports &3] Acct Subtotals 6/22/2011 10:34 AM 50 KB Microsoft Off
Misc Reperts -
Temp 53] Dept Subtotals 6/22/2011 10:34 AM 228 KB Microsoft Offi
Utilities '21 Dynamic Ranges Compare Vers  6/22/2011 10:34 AM 57 KB Microsoft Offi
Workflow 5] Dynamic Ranges stacked 6/22/2011 10:34 AM 49 KB Microsoft Offi
5§ Dynamic Ranges stacked I 6/22/2011 10:34 AM 44 KB Microsoft Offi
i5¥] Dynamic Ranges stacked III 6/22/2011 11:22 AM 57 KB Microsoft Offi
5] Income Statement By Month 6/22/2011 10:34 AM 73 KB Microsoft Offi
iZ Income Statement By Month Co  6/22/2011 10:34 AM 89 KB Microsoft Offi
54 Income Statement Variance 6/22/2011 10:34 AM 66 KB Microsoft Offi
E4] Multiple Levels 6/22/2011 11:22 AM 49 KB Microsoft Offi
4 m 3

File name:  Region comparison

+ | Description: Budget comparison by region

Budget Reports  Description: [

5 File Folder Save || Ciose |

You must have read/write permissions to a folder in order to save a report there. Alock icon displays
next to folders where you do not have read/write permissions. If you have access to a My Documents
folder, you can also save reports there for your own use.

If you later want to change the file name, location, or description, you can use Axiom Explorer. If you do
not have rights to access Axiom Explorer, you can edit the description by using Save As (Repository)
(save the file with the same name and location, but edit the description).

You can also choose to save the report to your local drive or to a network location, by using Save As
(Local File). In this case the report is not stored in the Axiom Software database and is considered to be a
non-managed file.

NOTE: Access to certain task panes (such as the Sheet Assistant) may depend on security
permissions defined at a folder level. When a new report file is created, the file location is assumed to
be the root of the Reports Library until the file is saved. Therefore access to task panes for brand new
reports depends on the user's permissions defined at the Reports Library level. If a user does not
have permission to the task panes at the Reports Library level but does have access at a sub-folder
level, then the user will not see the task panes until they save the file to that sub-folder.
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Creating a new report based on an existing file

You can use Save As to create a new report based on a copy of an existing report. You can save the
copied file to the Reports Library, or as a local non-managed file.

You can also create a report based on an existing Excel file, by opening the Excel file in Axiom Software. If
you want to use certain Axiom file features such as Axiom queries, you must add a Control Sheet to the
report. Then you can use Save As (Repository) to save the file to the Reports Library.

Refreshing a report with data

To update a report with the most current data from the database, refresh the file. A refresh does the
following:
o Updates active Axiom queries with data, according to the update settings defined for the query
o Updates Axiom functions with data
o Performs an Excel calculation

o Reapplies the currently active views (if applicable)

The refresh commands are located on the Axiom tab, in the File Options group:
o To refresh all sheets in the workbook, click Refresh.

o Torefresh the current sheet, click the down arrow on the right-hand side of the Refresh button,
and then click Refresh Active Sheet.

You may be prompted to define values before the refresh occurs. If so, these values will be applied to the
report to impact the data refresh.

TIP: You can also use F9 to refresh the entire workbook, and SHIFT+F9 to refresh only the active
sheet.

NOTE: Administrators can use the Refresh command on the Axiom Designer tab to perform more
targeted refresh actions, such as refreshing only a specific Axiom query.

Applying a Quick Filter to a report

Using the Quick Filter feature, you can apply a temporary filter to a report. This allows you to quickly view
the data at a different level of detail, without needing to alter the report configuration.

For example, you may be viewing an Income Statement report for the entire consolidated organization,
and you want to view the same report at a different level of detail, such as for just North America or just
the South region. You can use the Quick Filter to recalculate the report at the desired level of detail, and
then clear the filter when you are done.
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The Quick Filter is combined with your table security filters and any filters that are currently defined in
the report, such as sheet filters and filters defined for Axiom queries.

NOTE: The Quick Filter feature can also be used on file group utilities and drivers.

To apply a Quick Filter to a report:
1. Onthe Axiom tab, in the File Options group, click Quick Filter.

Hsave ~ [2Refresn ~  0ZQuick Filter
Iﬁ] Change View - Q:.Q\ Drill =
= GoTo ~ Freeze Panes

2. Atthetop of the dialog, specify how the filter should be applied:
o Workbook (default): The Quick Filter is applied to all sheets in the workbook.
o Active Sheet: The Quick Filter is only applied to the currently active sheet.

This selection may determine which hierarchies and tables are available in the dialog to build the
filter. See Hierarchy and table availability in the Quick Filter dialog.

3. Inthe Quick Filter dialog, define a filter using one of the following methods:

o Data Hierarchies: Select the desired hierarchy levels(s) from the hierarchies listed in the
dialog. As you select items in the hierarchy, the corresponding filter is automatically built in
the Filter box.

For example, you might have a hierarchy named Geography, which has local regions rolling
up into countries, and countries rolling up into world regions. You can select the desired
items that you want to see in the report, such as Europe, Asia, or North America as world
regions. For more information and examples, see Understanding hierarchy-based Quick
Filters.

o Manual Filter: You can manually type a filter into the Filter box using standard filter criteria
statement syntax. Fully qualified Table.Column syntax must be used.

o Advanced Filter: Click Advanced Filter to create a filter using any reference table columns
(not just hierarchy columns).
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‘I Edit the Quick Filter far the active sheet or workbook.

Apply Filter To: ® Workbook () Active Sheet

Data Hierarchies /bpﬁon 1: Select Advanced Filter

| <type here to filter val{  values from hierarchies
b & Accounts to auto-create a filter _ |
4 & Geography Dptlon 3: Click
b [] World Region Asia to switch to t_hE
b [] World Region Corporate AU‘JEHCEU Filter
b [] World Region Europe VIEWw

b ] world Region Nerth America
I % Managerial

Option 2: Type
a filter directly
in the Filter box

Example Quick Filter dialog

4. Click OK.

If the Quick Filter is applied to the entire workbook, a warning message informs you that the
entire workbook will be refreshed. If you do not want to see this message again in the future,
select Don't show this message again. Click OK to continue.

If the Quick Filter is applied to the current sheet, that sheet is refreshed and no warning message
appears.

If the file has been configured with GetCurrentValue("QuickFilter") functions, then these functions will
display the currently applied Quick Filter for your reference. If not, you can view the current Quick Filter
by clicking the Quick Filter button again. The current filter displays in the Filter box.
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Clearing the Quick Filter

Once a Quick Filter has been applied to a report, the filter remains applied until one of the following
occurs:

o Thefileis closed. Quick Filters cannot be saved in the file and are always cleared when the file is
closed.

o Anew Quick Filter is applied by using the Quick Filter button and selecting a different filter.

o The Quick Filter is manually cleared. To clear the Quick Filter, click the Quick Filter button again
and then click Clear Filter.

Hierarchy and table availability in the Quick Filter dialog

The hierarchies and tables shown in the Quick Filter dialog are based on the Axiom queries in the report.
Axiom Software looks up the primary tables for the queries, and only shows the hierarchies and
reference tables that are relevant to those primary tables. This is done to help ensure that the Quick
Filter will be applicable to at least one query in the report.

If the filter applies to the entire workbook, then Axiom Software looks at the primary tables for all Axiom
queries in the workbook. If the filter applies to the active sheet only, then Axiom Software looks at only
the primary tables for the Axiom queries defined on the active sheet.

NOTE: In the Advanced Filter view, only reference tables are shown unless the primary table has
potentially ambiguous lookup relationships. In that case, the primary data table is also shown so
that the selections can be made directly on these lookup relationships, to avoid any ambiguity. For
example, if the primary data table has columns PrimaryPhysician and SecondaryPhysician that both
look up to Physician.Physician, then the selection must be made through the primary data table so
that the correct path to Physician.Physician is used.

If the report uses GetData functions instead of an Axiom query, then all hierarchies and reference tables
are listed in the dialog because Axiom Software cannot determine the "primary table" in this context. In
this case, it is possible to define a Quick Filter that does not apply to any GetData functions in the
workbook. If this occurs, the filter will simply have no effect.

Understanding hierarchy-based Quick Filters

When you use hierarchies to create a Quick Filter, Axiom Software automatically creates the filter based
on your selections. When only one item it selected, the filter is simple—only data that matches the
selected item is included. For example, if you select Asia from a Geography hierarchy, you will get a filter
something like: Dept .WorldRegion="Asia"'.
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£ Quick Filter ?

1' Edit the Quick Filter far the active sheet or workbook.

Apply Filter To: ® Workbook () Active Sheet

Data Hierarchies Advanced Filter
<type here to filter values>
I & Accounts
4 & Geography
I WorldRegion Asia
b [] WorldR n Corporate
b [] WorldR gion Europe
b ] wor dRegion North America
I % Managerial
Filter: Clear Filter W

DEPT.WorldRegion = "Asia’

QK | | Cancel

Simple Quick Filter

NOTE: Sometimes when you select a single "child" item underneath a "parent" item, the child and
parent will be joined with AND. For example: DEPT.VP="'Jones' AND DEPT.Manager='Smith'.
This means that the DEPT table has other instances of Manager Smith that belong to different VPs,
so the compound statement is to ensure that you only get the data where Manager Smith is under
VP Jones. (You can manually edit the filter to remove the Jones portion of the statement if you want
to see all data for Manager Smith, regardless of VP). If instead Axiom Software constructs the filter as
just Dept .Manager="'Smith', that means all instances of Manager Smith are also under VP Jones.

You can select multiple items in the same hierarchy or from different hierarchies. Iltems from the same
hierarchy are combined using OR, which means data matching any of the selected items is included.

Items from different hierarchies are combined using AND, which means only data that matches both
selected items is included.
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il Edit the Quick Filter far the active sheet or workbook.

Apply Filter To: ® Workbook () Active Sheet

Data Hierarchies Advanced Filter
|{t}rpe here to filter values> |

I & Accounts
4 &5, Geography

b [+ WorldRegion Asia

r [ WorldRegion Corporate

8 WorldRegion Europe

b [] WorldRegion North America
I % Managerial

Filter: Clear Filter ¥
DEPT.WorldRegion in (‘Asia’, 'Europe’)

Example 1

In example 1, we have selected two items from the same grouping level in a single hierarchy, so a simple
filter criteria statement is created using IN. The resulting filter will include all data from Asia and Europe.
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il Edit the Quick Filter far the active sheet or workbook.

Apply Filter To: ® Workbook () Active Sheet
Data Hierarchies Advanced Filter
|{t}rpe here to filter values> |

I & Accounts
4 &5, Geography
b [] WorldRegion Asia
r [ WorldRegion Corporate
4 [m| WorldRegion Europe
v [ Country France
I Country ltaly
v [ Country UK
4 [m| WorldRegion North America
4 [m Country USA
b Region Corperate - Corporate Departments
b Region US Central - United States Central Sales Region
I Region US East - United States Eastern Sales Region

b Region US West - United States Western 5ales Region
I % Managerial

Filter: Clear Filter %
DEPT.Country = 'ltaly' OR DEPT.Region = "U5 East’

Example 2

In example 2, we have selected two items from different grouping levels, but within the same hierarchy.

In this case a compound filter criteria statement is created using OR. The resulting filter will include all
data that belongs to either Italy or US East.
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‘I Edit the Quick Filter far the active sheet or workbook.

Apply Filter To: ® Workbook () Active Sheet

Data Hierarchies Advanced Filter
|{t}rpe here to filter values> |

I & Accounts
4 & Geography
b [] WorldRegion Asia
r [ WorldRegion Corporate
r [ WorldRegion Europe
4 [m| WorldRegion North America
4 [m Country USA
b Region Corperate - Corporate Departments
b Region US Central - United States Central Sales Region
I Region US East - United States Eastern Sales Region
b Region US West - United States Western 5ales Region
o % Managerial
I [] VP Bree Sigman
i [#] VP David Prince
[ ve Evan Simpson
b ] VP Frank Martinez
|
|
|

(] ve Javier Guppy
[] vP Jen Smith
] vP Michelle Choi

Clear Filter %

(DEPT.Region = "US East’) AND (DEPT.VP = 'David Prince’)

Example 3

In example 3, we have selected two items from different hierarchies, so a compound filter criteria
statement is created using AND. The resulting filter will include only data that belongs to both US East
and VP Jason Guppy.

Saving a report

When you save a report, the report file is updated in the Axiom Software file system. If the report is
configured to save data to the database, a save-to-database also occurs.
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To save a report:
e Onthe Axiom tab, in the File Options group, click Save.

Your file permission settings in Security determine whether you can save a particular report. If a report is
open with read/write permissions, then you can save it.

If a report is open with read-only permissions, then clicking Save opens the Save As dialog. You can save
a copy of the report to any Reports Library folder location where you have read/write permissions, or to
your My Documents folder (if applicable). Alock icon displays next to folders where you do not have
read/write permissions to any folder in that folder tree.

If you do not have read/write permissions to any folder, then when you click Save you are informed that
you cannot save the file anywhere inside the Axiom file system. Alternatively, you can save a snapshot
copy of the file, or save a copy locally using Save As (Local).

NOTES:
« Some files may use a Control Sheet setting that causes the data in Axiom functions to zero
when the file is saved. This is a security precaution that is normally enabled in reports only.
You can click Refresh to restore the data.

« You may have non-managed report files that are saved on your local computer or a network
file share. The Save option also updates these files. However, a save-to-database cannot be
performed on non-managed files.

Save-to-database reports

Some reports may be configured to save data to the database. If the report is configured to save to the
database, then the file is validated before saving. If errors are found, the file still saves but the data save
is stopped and the errors are displayed in the Save Errors pane. These errors must be corrected before
data can be saved to the database. If no errors are found, then a confirmation message displays, with
information about the number of records saved.

Your file permission settings in Security determine whether you can perform a save-to-database for a
particular report. Note that the permission to save data is managed separately from the file access
permission. Therefore, it is possible that you could have read-only permissions for the file, but still have
rights to save data (or the opposite—you could have read/write permissions for the file, but not have the
rights to save data).

When you click Save, Axiom Software automatically performs all save actions that your user rights allow
and that the file is configured to perform. If desired, you can use the additional save options to only save
the file, or to only save data.
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NOTE: Save-to-database reports are often constructed so that the data in the reports is meant to be
transitory (unlike plan files, where the data in the plan file is meant to be retained, to show how plan
data was calculated). Therefore, the process of saving the file without saving data (and vice versa) is
often not a concern as it would be for plan files.

To save only the file:
o Inthe Axiom tab, in the File Options group, click the down arrow to the right of the Save button,
and then click Save File Only.

The plan file is saved. All save-to-database processes are ignored.

To save only the data:

¢ Inthe Axiom tab, in the File Options group, click the down arrow to the right of the Save button,
and then click Save Data Only.

Data from the file is saved to the database. The file itself is not saved.

Saving a copy of a report

You can save a copy of a report using Save As features. You might want to save a copy of a report to use
as a starting point to create a new report, or to create an archive copy before making changes to the
report.

In most cases, you should save the report to the Axiom Software file system (in the Reports Library).
However, it is possible to save report files outside of the Axiom Software system (as non-managed files).
Non-managed files have limited functionality, and are not covered by Axiom Software security or
included in system processes.

To save a copy of a report to the Reports Library:

1. Onthe Axiom tab, in the File Options group, click the down arrow to the right of the Save button,
and then click Save As (Repository).

TIP: The Save As options are also available by right-clicking the file tab.

The Save As dialog opens, displaying the contents of the Reports Library.

NOTE: By default this dialog only displays files with the same file extension as the current file. If
you want to view all file types when using this dialog, select View > Show All Files. This setting
will be remembered.

2. Inthe left-hand side of the dialog, navigate to the folder in the Reports Library where you want to
save the file.
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You must have read/write permissions to a folder in order to save a copy of the report there. A
lock icon displays next to folders where you do not have read/write permissions to any folder in
that folder tree.

3. Inthe File name box, type a name for the new report.
4. Optional. In the Description box, type a description for the report.

5. Click OK.

To save a copy of a report locally (as a non-managed file):

1. Onthe Axiom tab, in the File Options group, click the down arrow to the right of the Save button,
and then click Save As (Local File).

TIP: The Save As options are also available by right-clicking the file tab.

The Save As dialog opens.

2. Navigate to the desired location on your local computer or on a network file share, and then click
Save.

You can change the name of the file and its file format when saving. In the Excel Client, you can
save the file using any file format that your Excel version supports. In the Windows Client, you can
save the file as XLSM, XLSX, or XLS.
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Using Axiom File Features

Axiom files support a number of features that can be used in plan files, reports, and any other type of
Axiom file.

Changing views in an Axiom file

If views have been defined for a sheet, you can change the view to change how information is presented
in the sheet.

For example, you might have the option to switch between a Detail sheet view and a Summary sheet
view. You might have the option to toggle certain rows and columns as hidden or shown, such as to
select which quarters you want to view. The specific view options available depends on the file design.

To change the views in a sheet:
o Onthe Axiom tab, in the File Options group, click Change view.

This displays a menu showing all views defined in the current sheet. You can click on a view name to
activate that view.

Some views are single-selection, which means that activating one view deactivates the prior view. Other
views allow for "additive" selections so that multiple views can be active at one time. Some views may
open a dialog where you can select specific sets of rows or columns to show. The specific behavior of
each view depends on the file designer. Ideally the name of the view will give you a good idea of what to
expect when that particular view is selected.

After any view is made active, the freeze panes setting for the sheet is also reapplied. Axiom Software
keeps track of the currently active views in a sheet and will reapply them after you perform certain
activities in a sheet, such as refreshing an Axiom query or inserting a calc method.

Jumping to GoTo bookmarks in an Axiom file

If an Axiom file has bookmarks defined in the file, you can go directly to bookmarked points by using the
GoTo feature.

To go to a bookmark:
e Onthe Axiom tab, in the File Options group, click GoTo.
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Alist appears underneath the GoTo button, listing sets of bookmarks. For example, there may be a set of
bookmarks for each sheet in the file.

Selecting a set brings up a list of bookmarks in that set. Click a bookmark in the list to go directly to that
area.

= GoTo -
||=|:| Budget Summaries # Budget Summaries actions on sheet Budget
5 | Payroll » = |Statistics

Revenue

Marketing

Owverhead

Travel

0 TR0 TR 0

Other Expenses

Example GoTo bookmarks

Freezing or unfreezing panes in a sheet

Sheets in Axiom files can be configured to freeze panes at a certain location automatically when the file is
opened. You can toggle these frozen panes on and off by using the Freeze Panes option.

This option is only available if the sheet is not protected. If you have security rights to unprotect the
sheet, the Freeze Panes option will become available once the sheet is no longer protected.

To freeze or unfreeze panes in a sheet:
e Onthe Axiom tab, in the File Options group, select or clear the Freeze Panes check box.

If panes are frozen, clearing the check box unfreezes the panes.

If panes are unfrozen, selecting the check box freezes the panes. If a sheet has freeze panes settings
configured on the Control Sheet, selecting the check box applies that setting, regardless of where your
cursor is in the spreadsheet. Otherwise, the Freeze Panes option works like the Microsoft Excel feature,
and freezes panes at the current cursor position.

NOTE: If you have toggled freeze panes off, and then you use Change view to select a view (or if you

otherwise perform an action that causes a view to be reapplied), the freeze panes settings for the
sheet are reapplied.

Administrators can alternatively use the Show Everything command to turn off all protections and
display controls at once, including frozen panes.
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Drilling the data in an Axiom file

Axiom Software provides several options to drill the data in an Axiom file:
o Drill down. You can "drill down" a data row to view the data at a different level of detail. If

hierarchies have been set up for your data, you can drill down predefined hierarchy levels. You can
also drill down to the "bottom" of the data or choose any relevant column for drilling.

o Drill through. You can "drill through" the data in a specific cell to view the associated sub-GL detail
or transactional data. This feature is only available if drill through has been enabled for the source
data, using drill-through definitions.

o Custom drilling. You can drill data using Axiom Software's custom drilling feature. Custom drilling
is extremely flexible and can be set up to drill virtually any source data, to any user-defined drilling
level. Custom drilling must be set up in advance for the report, and requires advanced report
writing knowledge to configure.

Drilling data: Using Drill Down
You can drill down a row in an Axiom file to view the data at a different level of detail. For example, if a

row of data in the report shows budget totals for the Northwest region, you can drill the row to see the
values for each individual department in that region. This type of drilling is known as "drilling down."

Drilling down can be used in report files or plan files, but the most typical use case is in reports. In plan
files, most data is already at the lowest level of detail, so drilling down may only be useful if the plan file
has a summary sheet with drillable data.

If a row is eligible for drilling, you can drill down hierarchies that have been set up for the data. For
example, your system may have a Geography hierarchy such as: Country > Region > DEPT. You can also
choose to drill directly to the "bottom" of the data (all dimensions), or drill using any related column in
the data.

You can drill data rows that result from an Axiom query or that are built using GetData functions. A few
limitations apply, and some advanced configurations have special behaviors. For more details, see the
drill down setup discussion in the Axiom File Setup Guide.

To drill down a row of data:
1. Placeyour cursor in the row of data that you want to drill.

If you are drilling a row of data that is part of a multiple-row calc method, then you can place your
cursor anywhere in the multiple-row calc method. The drill results will be for all rows of the calc
method.

2. Onthe Axiom tab, in the File Options group, click Drill, and then select the desired drill level from
the Drill Down sub-menu.
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Drill option Description

Hierarchies Your system may have defined hierarchies that outline logical drilling
paths. For example, you may have a Geography hierarchy that allows
you to drill from Country to Region to individual departments.

Hierarchies are defined per dimension (on the relevant reference
table), and are specific to your system.

On the Drill menu, hierarchies are listed first if defined. Only
hierarchies relating to the current data are shown.

NOTES:

o Ifthe datato be drilled comes from multiple data tables, then only
the hierarchies from shared lookup reference tables are available.

o Ifyou aredrilling an Axiom query, hierarchy options will be grayed
out on the menu if you are already at that level of detail. For
example, if the report is at the VP level already, VP is grayed out on
the menu. However, when you are drilling GetData functions, all
hierarchy options are present on the menu, because the GetData
functions may all have different "sum by" levels.

All Detail Selecting All Detail takes you directly to the very "bottom" of the
data. Essentially, you are drilling based on all dimensions at once,
rather than on one specific dimension.

The drill sheet will contain one column for each dimension (key
column)in the data, including a description column for each (if
applicable).

NOTE: If the row contains data from more than one data table, then
this option is only available if the tables share the exact same key
columns and all of the key columns are lookup columns.
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Drill option Description

Choose Columns Selecting Choose Columns allows you to drill based on any relevant
column for the current data, including non-lookup key columns.

In the Select Columns dialog, select the column (or columns) that you
want to drill by. You can select from any column in the primary data
table, as well as any column in lookup reference tables.

This drilling option is entirely free-format. There is no validation to
determine if a particular column selection makes sense in relation to
the current data.

NOTES:
o Calculated fields do not display and cannot be used for drilling.

« Ifthe row contains data from multiple data tables, then only
columns from shared lookup reference tables can be selected.

Atemporary file opens, named Drill Filename.x1lsx. This file contains a drill sheet named Drill_
DrillLevel, that shows the results of the selected drill. The top of the drill sheet displays your current drill
context.

If you want to continue to drill, you can do either of the following:

o Return to the original sheet (or a different sheet) in the original file, and then select a new drill
level. If you left the temporary drill file open, then a new drill sheet will be added to that file, with
the new drill results. If you closed the temporary file, then Axiom Software creates a new
temporary file.

o Select arow in the drill sheet, and continue drilling to a lower level of detail. A new drill sheet will
be created in the temporary file with the results.

When you are finished viewing the drill results, close the temporary file. While it is possible to use Save
As to save the temporary file, typically this is not useful. You can always perform the drill again at any
time to see the results. If you find yourself performing the same drill over and over, you may want to
create a new report that displays the data at the desired level. If you want to share the drill results with
someone else, the best approach is to create a snapshot copy of the temporary drill file.

Double-click drilling

If Axiom double-click actions are enabled for the sheet, then you can drill a row of data by double-clicking
it. In this case, a dialog opens, listing the drilling options for the current row selection. Select the desired
drill level and then click OK.

NOTE: Certain double-click actions may take priority over drilling.
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Drilling data: Using Drill Through

You can drill a specific data point in an Axiom file to see the associated sub-GL detail or transactional data.
This feature is only available if "drill through" has been enabled for the source data, using a drill-through
definition.

The drill-through feature can be used in either report files or plan files.

You can drill data values that result from an Axiom query or from a GetData function. A few limitations
apply, and some advanced configurations have special behaviors. For more details, see the drill through
setup discussion in the Axiom File Setup Guide.

To drill through the data in an Axiom file:

1. Place your cursor in the cell that contains the value you want to drill.

2. Onthe Axiom tab, in the File Options group, click Drill, and then select the desired drill from the
Drill Through sub-menu.

If Drill Through is not listed on the menu, then the selected cell is not eligible for drill through.
Check to make sure that your cursor is in the appropriate cell.

Atemporary file opens, named Drill Filename.x1lsx. This file contains a drill sheet named Drill_
DrillLevel, that shows the results of the selected drill. The top of the drill sheet displays your current drill
context.

NOTE: When you drill through data, you drill from the source table to an entirely different table that
holds the detailed data. The data results are entirely dependent on the drill-through configuration
(unlike drill down, where the drill data is queried from the same table and derived programmatically).
If the drill results are not as you expect, please contact your system administrator.

Double-click drilling

If Axiom double-click actions are enabled for the sheet, then you can drill a data value by double-clicking
it. In this case, a dialog opens, listing the drilling options for the current selection. Select the desired drill
level and then click OK.

Drilling data: Using custom drilling

If an Axiom file has been set up for custom drilling, then you can drill the data in the file to view it at a
different level of detail, or to view a set of related data. Custom drilling is most often used in reports, but
it can be applied to any Axiom file.

Each sheet can have one or more custom drilling options. Custom drilling is completely configurable and
can be set up to return any set of data. If you have any questions about the custom drill options in a
particular file, contact the report designer or a system administrator.
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Custom drilling can be initiated by double-clicking a row, or by using the Drill menu. Double-click drilling
is only available if one of the drilling options in the file has been configured to use it. Otherwise, all active
custom drills can be initiated from the Drill menu. If custom drill options are available for the file, they
are listed under the subhead Custom Drrills.

If a file is not set up for custom drilling, then only the "built-in" drilling options display on the Drill menu.

To drill the data in an Axiom file using custom drilling:
1. Do one of the following, depending on the desired drilland how the file is configured:
o Double-click the row that you want to drill.

o Place your cursorin the row that you want to drill. On the Axiom tab, in the File Options
group, click Drill and then select a drill option listed under the Custom Drills subhead.

TIP: You can also initiate drills from the right-click context menu.

2. Ifthedrill option requires you to select a drilling level, then the Drill dialog opens, displaying the
available levels. Select a level and then click OK.

If the drill option has just one level, then this step does not apply.

A report file opens, displaying the results of the selected drill. This target drill report is a separate file that
is opened using your normal file security rights. When you are done viewing the drill data, you can close
the report.

NOTE: When custom drilling, drill results are presented differently than when using the built-in
drilling features. Custom drilling uses a separate target report that has been specially configured to
present the drill results. You cannot continue drilling the target report unless the target report has
also been configured to support custom drilling (or unless the data in the target report is eligible for
built-in drilling).
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Printing Files and other File Output
Options

Axiom Software has a variety of features that can be used to create file output and share data with
people throughout your organization.

Printing an Axiom file

You can print an Axiom file on a per sheet basis by using the Print command in the File Output group of
the Axiom tab.

Each sheet can have one or more defined print views. The print views can be used to print different
"views" of the sheet, and to set certain standard print options such as the print orientation. For example,
for a plan file, you might have one print view that prints a "summary" view of the sheet (with certain
columns and rows hidden for printing), and another print view that prints a "detail" view of the sheet
(with all columns and rows visible).

If a sheet has no predefined print views, then the sheet can be printed using the settings defined for the
spreadsheet using standard Excel printing features. For more information on defining print settings for a
spreadsheet, see the Microsoft Excel Help. In the Windows Client, the spreadsheet print settings are
defined in the Workbook Explorer, in the Page Setup section for each sheet.

NOTE: You can always print the file using standard spreadsheet print functionality, even if Axiom
Software print views have been defined.

To print an Axiom file:

1. Onthe Axiom tab, in the File Output group, do one of the following:

o Ifyou want to be able to select print views from all sheets in the workbook, click Print.

o Ifyou want to print only the current sheet, then click the arrow to the right of the Print
button, and then click Print This Sheet.

The Print Sheets dialog opens. This dialog lists the available print views for the entire workbook or
for the current sheet, depending on how you entered the dialog. To sort this list by the Sheet
Name or Print View Name, click the column header.
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Print Sheets - Budget_41500.xIsm ?

©

Eﬂ Select the sheets and the views that you wish to print.

[] Sheet Name Print View Mame Print Details Print Preview
L] Summary Standard View/Edit Print Preview

[ Budget Print Budget Months View/Edit Print Preview

L] Payrall Print Skill Mix Summary View/Edit Print Preview
L] Payrall Print Summary View with Roster View/Edit Print Preview

L] Payrall Standard View/Edit Print Preview

Current Printer:

Choose Printer... Print

Example Print Sheets dialog

NOTES:
« Ifasheet does not have a defined print view, then it is listed with a print view name of
"Default," and will use the print settings defined for the spreadsheet.
o Control Sheets cannot be printed using the Axiom Software printing feature, whether
they are visible or hidden. If you want to print a Control Sheet, use the standard
spreadsheet printing features.

2. Inthe Print Sheets dialog, select the sheet / print view combinations that you want to print.

If you want to print all print views for all sheets, then select the check box in the column header to
select all.

If you opened this dialog by using Print This Sheet and the sheet has only one available print
view, then that view is selected by default.

3. You can also do any of the following before printing:

o View and edit the print settings. If you want to view and potentially change the print
settings for a selected view, click the View/Edit link. In the Print Options dialog, you can
change any of the print settings, for the current print job only (the changes are not saved in
the file).
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o Preview a print view. If you want to preview a print view, click the Print Preview link. The
native spreadsheet Print Preview feature will open to preview the print job. Only one view
can be previewed at a time.

o Select a printer. If you want to print to a different printer than your default printer, click
Choose Printer at the bottom of the dialog. In the Printer Setup dialog, select the printer
that you want to use, and then click OK.

NOTE: In the Windows Client, the printer is always your default printer unless you
change it for a particular print job. In the Excel Client, the printer starts as your default
printer, but if you change the printer for a print job, the changed selection will be
remembered for any future print jobs in the current session.

4, Click Print.

The selected items are printed.

Printing multiple plan files

You can print multiple plan files in batch by using the Print Plan Files feature. You can select multiple
plan files within a file group, and then select one or more print views for each plan file.

NOTE: The available print views for each plan file are based on the template that was used to create
the plan file. If a plan file has been modified to contain a print view that is not in the source template,
that print view will not be available when using Print Plan Files. You can still print the view by
opening the file and using Print.

To print multiple plan files from a file group:

1. Onthe Axiom tab, in the File Output group, click the down arrow to the right of the Print button,
and then click Print Plan Files.

The Print Plan Files dialog opens.

NOTE: If you have access to the file group menu for a file group, then you can access Print
Plan Files from the file group menu. In this case, the current file group is pre-selected in the
dialog.

2. From the File Group list, select the file group that contains the plan files that you want to print.

Only one file group can be printed at a time. Once a file group is selected, the dialog displays a list
of the available plan files.

3. Inthe Select plan files to print section, select the plan files that you want to print.
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e You can sort and filter the list using standard Axiom grid functionality to find the plan files
that you want to print.

o To select multiple plan files at once, highlight the plan files, and then right-click and select
Select. If you want to print all plan files that currently display in the dialog, select the check
boxin the header row.

Once at least one plan file has been selected, you can select which print views to print.

4. Inthe Select views to print section (at the bottom of the dialog), select the views that you want
to print. You must do this for each source template used for the selected plan files.

Select views to print: & Select at least one print view per ternplate

Print Views Template

0 zelected Select print views Budget Template

o Click the Select print views link.

o IntheSelect Print Views dialog, select the sheet / print view combinations that you would
like to print, and then click OK.

If you want to see the settings that will be applied to the print job, click the View link. Print
settings are read-only in this context.

NOTE: All template sheets are listed in this context (except for Control Sheets), including
sheets that you may not normally see in plan files because they are hidden. If you select
a sheet that is hidden in one of the selected plan files, it will not be printed. A message
will inform you of the unprinted sheet when the printing process is complete.

o Repeat this process for each source template.

If all of the selected plan files were built using the same template, then there will be only one
template listed. If the selected plan files were built using multiple templates, then multiple
templates will be listed. The print selections for each template will only apply to the plan files that
were built using that template.

5. Ifyou want to print to a different printer than your default printer, click Choose Printer at the
bottom of the dialog. In the Printer Setup dialog, select the printer that you want to use, and then
click OK.

NOTE: In the Windows Client, the printer is always your default printer unless you change it
for a particular print job. In the Excel Client, the printer starts as your default printer, but if you
change the printer for a print job, the changed selection will be remembered for any future
print jobs in the current session.
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6. Click Print.
The selected plan files are printed, using the print view selections.

If a selected print view is not found in a target plan file, a message displays at the end of the process,
listing the affected plan file and the relevant sheet / print view. This may occur if the print views in either
the template or the plan file have been modified after plan file creation.

Taking a snapshot copy of an Axiom file

You can take a “snapshot” of an Axiom file, so that you can save a copy as a normal Excel file and then
open it in Microsoft Excel (without needing Axiom Software). For example, you may want to send a copy
of a report to someone that does not have access to Axiom Software.

When you create a snapshot of an Axiom file, the file is copied as an XLSX file, and the following occurs:

o All Control Sheets and any hidden sheets are automatically removed. You can choose whether to
include all remaining sheets, or only the active sheet.

o All Axiom formulas are replaced with values. You can choose whether to retain Excel formulas, or
replace them with values. If Excel formulas are preserved, certain formulas will be replaced with
values if they reference sheets or cells that are deleted as part of the snapshot processing.

o Rows and columns flagged for delete are deleted.
Due to the file format, any VBA macros in the file are also removed.

To take a snapshot of an Axiom file:
1. Open the file in Axiom Software.

2. Onthe Axiom tab, in the File Output group, click Snapshot.
The Snapshot File dialog opens.
3. Inthe Formula Replacements section, select one of the following:
o Convert All Formulas (default): All formulas are replaced with values.

o Retain Excel Native Formulas: All Excel formulas in the spreadsheet will be retained as is,
with one exception. If a cross-sheet formula references a sheet that will not be present in
the snapshot (depending on the Sheets To Snapshot setting), that formula will be replaced
with values.

NOTE: If the file contains a pivot table, this option must be selected in order for the
pivot table to work in the snapshot copy.
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4. Inthe Sheets to Snapshot section, select one of the following:
o Limit to Active Sheet (default): Include only the active sheet in the snapshot.

o All Sheets In File: Include all sheets in the file (except any Control Sheets and hidden
sheets, which are always removed).

5. Click OK.

The snapshot file is created and is opened in Axiom Software. The navigation tab for the file is titled either
Sheetname_snapshot (if the snapshot contains only one sheet) or FileName_snapshot (if the snapshot
has multiple sheets). You can now use Save As features to save the file locally or to a network location.

NOTE: If you are using the Excel Client and you want to save a copy of the snapshot as a PDF file, you
can use standard Excel functionality to do so. Use File > Save As, and then select PDF as the file type.
This is an Excel-specific feature that is not available in the Windows Client.

If you want to email a snapshot to someone directly, you can use the E-Mail Workbook feature. This
creates a snapshot and attaches it to an email (instead of opening it in Axiom Software).

Emailing a snapshot of an Axiom file

You can email a snapshot of an Axiom file using the E-mail feature on the Axiom tab. Axiom Software
creates a snapshot copy of the file and attaches it to an email. The copy can then be viewed outside of
Axiom Software by someone who may have no access to the system. When you use this feature, Axiom
Software creates a snapshot copy of the file just like it would if you used the Snapshot feature.

The email can be sent using your default email client (such as Microsoft Outlook), or you can send the file
using the Axiom Software Scheduler email service. For example, you may be using Axiom Software on a
shared client server where you do not have access to a local email client, and therefore you would use
the Axiom Software email service to send the email. Note that the Scheduler email service does not
support HTML format for email.

If you use the Scheduler service, the email message is sent the next time the Scheduler SMTP Email
Delivery task is run. The frequency of Scheduler email delivery depends on how this task has been
configured in your environment, but typically it runs continuously (or close to it).

NOTES:

« The name of the emailed file is either Sheetname_snapshot (if the snapshot contains only one
sheet) or FileName_snapshot (if the snapshot has multiple sheets). The name cannot be
changed.

« You can also email snapshot copies using the File Processing feature. File processing is typically
used when you want to automate the process and employ multipass processing to send the
same file to different people using different data. The E-mail feature is best used to send "one-
off" snapshots as needed.
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To email a snapshot copy of an Axiom file:

1. Open thefile in Axiom Software.
2. Onthe Axiom tab, in the File Output group, select E-mail.
The E-mail Active Workbook dialog opens.
3. ForSend As, select Snapshot.
4. For Send using, select one of the following:
o Outlook: Send the email using the default email client on your local machine (for example,

Microsoft Outlook). The name of this option may be customized for your organization.

NOTE: This option is not available if you are using Axiom Software on a shared client
server.

o Axiom Mail Service: Send the email using the Axiom Software Scheduler email service.

5. Complete the following Snapshot Options in the dialog:

Option Description

Send file as Select XLS, XLSX, XLSM, or PDF. XLSX is selected by default.

NOTE: PDF is not available in the Axiom Windows Client.

Include Select one of the following:

o Entire Workbook: All sheets are included in the snapshot (except
Control Sheets and hidden sheets, which are always removed).

o Active Worksheet Only (default): Only the active worksheet is included
in the snapshot.
Formulas o Convert All Formulas (default): All formulas are converted to values.

o Retain Excel Native Formulas: Axiom formulas are converted to
values, but Excel formulas are left as is. Note that if an Excel formula
references a sheet that is not included in the snapshot, that formula
will be converted to a value.

NOTE: If the file contains a pivot table, this option must be selected in
order for the pivot table to work in the snapshot copy.

This option does not apply if PDF is the selected file type.

6. Click OK.

If you selected to send the file using your default email client, then a new email message opens, with the
snapshot file attached. You can then specify the recipient, subject, and body text for the email, and then
send it.
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If you selected to send the file using the Axiom mail service, then an E-Mail dialog opens so that you can
specify the recipient, subject, and body text for the email. In the address boxes (To, Cc, and BCC), you
can either type an email address, or click the button to select an Axiom Software user. If you select a
user, the email will be sent using the user's email address as defined in Axiom Software security. When
you click OK, the email settings are saved to the database, to be sent the next time the Scheduler SMTP
Email Delivery task is run.

Notes for administrators

If desired, you can customize the name of the default email client option. By default, "Outlook" is used
because most customers have Microsoft Outlook on their client machines. To customize the name, use
the DefaultEmailClientName system configuration setting. For more information, see the System
Administration Guide.

Emailing a hyperlink to an Axiom file

You can email a hyperlink to an Axiom file using the E-mail feature on the Axiom tab. Axiom Software
creates a URL hyperlink to the file and includes it in an email. The email recipient can click on the link to
launch the system and open the file directly, assuming that the recipient is an Axiom Software user who
has rights to access the file.

NOTE: The email hyperlink feature is not supported for use with the Axiom Software shared client.

The email can be sent using your default email client (such as Microsoft Outlook), or you can send the file
using the Axiom Software Scheduler email service. For example, you may be using Axiom Software on a
shared client server where you do not have access to a local email client, and therefore you would use
the Axiom Software email service to send the email. Note that the Scheduler email service does not
support HTML format for email.

If you use the Scheduler service, the email message is sent the next time the Scheduler SMTP Email
Delivery task is run. The frequency of Scheduler email delivery depends on how this task has been
configured in your environment, but typically it runs continuously (or close to it).

NOTES:

« Alternatively, you can obtain a URL to an Axiom file using a variety of ways and then paste it
into an email that you create manually. For example, you can use GetDocumentHyperlink or
right-click a file in Axiom Explorer to obtain a URL. The email hyperlink feature is provided as a
convenience to quickly send a hyperlink to the current file.

« The email hyperlink feature cannot be used to send a hyperlink to open a form-enabled file as
an Axiom form; the source file will always be opened as a spreadsheet.

o The hyperlink included in the email uses the same format as hyperlinks generated using
GetDocumentHyperlink, including the differing URL format for systems using SAML or
OpenlD Authentication.
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To email a hyperlink to an Axiom file:

1. Open thefile in Axiom Software.

2. Onthe Axiom tab, in the File Output group, select E-mail.
The E-mail Active Workbook dialog opens.

3. ForSend As, select Document Link.

4. For Send using, select one of the following:

o Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

o Axiom Mail Service: Send the email using the Axiom Software Scheduler email service.

5. Optional. Complete the Document Link Options in the dialog:

Option Description

Sheet Filter If desired, enter a filter to apply to the file when it is opened. You can type
the filter statement or use the Filter Wizard.

The filter is applied like a Quick Filter and affects any data queries in the
file. For example, Dept .Region="West' means that all data queried will
be limited to the West region.

If desired, you can specify a table or table type to apply the filter to, using
the same filter syntax that is available for the GetDocumentHyperlink
function. In this case you must manually type the filter syntax because the
Filter Wizard does not account for this type of syntax.

Cell Address If desired, specify the cell to be made active when the document is
opened. For example:

Sheetl1!D22

If the specified location would not be in view normally then the file will be
scrolled to that location; otherwise the file will open in its default view with
the cursor placed at that location.

6. Click OK.

If you selected to send the hyperlink using your default email client, then a new email message opens,
with the hyperlink included in the body text. You can then specify the recipient, subject, and additional
body text for the email, and then send it.

If you selected to send the hyperlink using the Axiom mail service, then an E-Mail dialog opens so that
you can specify the recipient, subject, and additional body text for the email. In the To and Cc boxes, you
can either type an email address, or click the button to select an Axiom Software user. If you select a
user, the email will be sent using the user's email address as defined in Axiom Software security. When
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you click OK, the email settings are saved to the database, to be sent the next time the Scheduler SMTP
Email Delivery task is run.

Notes for administrators

If desired, you can customize the name of the default email client option. By default, "Outlook" is used
because most customers have Microsoft Outlook on their client machines. To customize the name, use
the DefaultEmailClientName system configuration setting. For more information, see the System
Administration Guide.

Processing a report

If a report is set up to use file processing, you can process the report to automatically perform actions
such as:

o Save snapshot copies of the file and automatically email them to various recipients
o Export datain the file to a CSV or TXT file

o Save datain thefile to the database as part of a multipass process

o Collect multiple output files into a single report package

o Process multiple reports in batch

This topic explains how to process a file that has already been configured for file processing. For details
on how to set up a file for file processing, see the Axiom File Setup Guide.

NOTES:

o The File Processing menu command and the associated task pane are only available to
administrators or to users with the Allow File Processing permission for the current file.

o Other file types can be set up to use file processing, but the most common useis in a report.

To process a file using file processing:

1. Open thefile. If you want to see what the file is configured to do during file processing before
executing it, you can check the settings in the File Processing pane.

2. Onthe Axiom tab, in the File Output group, select File Processing, and then select one of the
following:

e Process File: Thefile is processed once "as is." The file is refreshed and the file processing
action is performed. No multipass filter or settings are applied.

o Process File Multipass: The file is processed multiple times, with a unique filter applied for
each pass. For example, if the file is set up to process by DEPT, then the file is processed
once for each department. The data queries in the file are automatically filtered to return
data for the current pass department only.

The file processing settings must be configured for multipass processing. Multipass
processing does not apply if the file is configured to use batch or file collect.
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TIP: You can also process the file directly from the File Processing pane (in the Actions section),
or by using the right-click context menu.

Once file processing is initiated, the following occurs:

o Thefileis refreshed. If you are performing multipass processing, the file is refreshed using a data
filter for the current pass item.

o Thefile processing action is performed. If you are performing multipass processing, the action
may be performed after each pass, or it may be performed once all passes are complete,
depending on the file processing settings.

A status bar displays the progress of the file processing. When the processing is complete, a confirmation
box displays information about the process, such as how many passes were performed, how many files
were created, etc.

Note that the file itself is not saved as part of file processing. You can process a file even if you have read-
only rights to the file. However, if the file processing is set up to save to the database, you must have
rights to save data for that file.
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Using the Data Explorer

Using the Data Explorer, you can analyze and report on your data using an intuitive drag-and-drop
interface. You can explore your data and see results immediately, without the overhead of designing and
formatting a more formal report.

The Data Explorer is ideal for performing quick on-the-fly analysis. You can open a new Data Explorer
instance at any time to simply view and explore data, or you can save certain settings in a permanent
Data Explorer file that you can then reuse as needed whenever you want to analyze that set of data.
Saved Data Explorer files are stored in the Reports Library and can be shared with other users.

About Data Explorer

Using the Data Explorer, you can perform drag-and-drop analysis on your Axiom Software data. To view
data, you drag values and dimensions from the Available Fields to the query settings at the top of the
screen. This topic provides an overview of how the Data Explorer works.

Prerequisites

In order to expose data to the Data Explorer, one or more data sets must be defined for your system in
the Table Administration area of the Desktop Client (Excel Client or Windows Client). Data sets are
defined collections of tables and columns in your database. When creating a new Data Explorer file, you
select which data set you want to use to determine the data that is available for analysis.

Accessing the Data Explorer

The Data Explorer is viewed using the Axiom Web Client. You can access the Web Client directly and use
the Data Explorer, or you can create and open Data Explorer files from within the Excel Client or the
Windows Client (this will automatically launch the Web Client in your browser). Your browser must meet
the minimum technical requirements for use of the Axiom Web Client in order to use the Data Explorer.

Working in the Data Explorer

The Data Explorer is designed so that users do not need detailed knowledge of their database structures
in order to view data. The Data Explorer works by simplifying data into two categories, values and
dimensions. Values are the data values that you want to report on, such as budget data for the first
guarter, or actuals data for last year. Dimensions represent how you want that data grouped and
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displayed. For example, do you want to see budget data by account or department, or by groupings
such as category, company, region, VP, etc.?

To use the Data Explorer, you can simply drag and drop your desired values and your desired row
dimension. You can also optionally specify a column dimension—for example if you want to compare
revenue budgets for next year by region, with a region in each column. You can view the resulting data in
an easy-to-read grid display, or you can click a button to automatically generate various charts and

graphs based on the data.
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The user's table permissions as defined in security always apply to the data displayed in the Data
Explorer, just as they would when refreshing a regular report. The user can see all data set names and all
column names, but the data query will always be filtered according to the user's security permissions.

Saving and sharing Data Explorer files

You can use the Data Explorer as a temporary tool for data analysis, or you can save Data Explorer files
for your future use and/or to share with other users. All save actions are performed using the toolbar at

the top of the Data Explorer.

When you save a Data Explorer, the current query settings are saved as a starting point. The next time
the file is opened, it will start with the saved settings for Value, Row, Column, and Filter. You can change
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these settings as desired to perform further analysis in the current session. You can then close the file
without saving the setting changes, or you can save the file to set a different "starting point" for the file.
You can also save a copy of the file with these new settings.

Data Explorer files are stored in the Reports Library, using a special icon: 1. Access to Data Explorer files
is controlled just like any other file in the Reports Library, using the file permission settings defined for
the folder or the file in Axiom Software security. Users with read-only access can open the Data Explorer
file to view the data and modify settings for the current session, and they can use Save As to save a copy
of the file (if they have read/write access to a report folder). Users with read/write access can modify
settings in the Data Explorer file and save it.

Libraries

~ |3l Reports Library
b Budget Reports
- Data Explorers
g Actuals
I3 Budget
File Processing
4 Forms

Data Explorer files in the Reports Library

Users can open Data Explorer files from the Reports Library in the Excel Client or the Windows Client, or
they can go to the Data Explorer page in the Web Client to browse available files. New Data Explorer files
can also be created in all environments.

Once a Data Explorer file has been saved, you can easily share it with other users by sending them the
hyperlink to the file. If you have the file open in the Web Client, then you can simply copy and paste the
URL from your browser window. In the Excel Client or Windows Client, you can right-click the file in the
Reports Library and choose Copy shortcut to clipboard. The other user must have the appropriate
permissions to view the file.

Creating a new Data Explorer

You can create a new Data Explorer using the Excel Client or the Windows Client, or using the Web Client.
In either case, once the Data Explorer session has been created, it is opened in the Web Client and the
interface from that point is the same.

You can choose whether to save the new session as a Data Explorer file, or you can use the Data Explorer
session as a temporary tool for ad-hoc analysis and not save it.

NOTE: Your system must have at least one defined data set in order to create a Data Explorer.

User Guide Axiom Software | 96



To create a new Data Explorer in the Excel Client or Windows Client:

1. Onthe Axiom tab, in the Reports group, click Reports > New Data Explorer.

If this menu item is not present, this means that no data sets have been defined in your system.
An administrator must first define one or more data sets.

2. Inthe New Data Explorer dialog, select the data set that you want to use with the Data Explorer,
and then click OK.

Data sets are predefined collections of tables and columns. The data set determines the available
data for the Data Explorer session.

The new Data Explorer opens in the Web Client (in your browser). The available fields are the fields
allowed by the selected data set. You can now work with this Data Explorer as desired.

To create a new Data Explorer in the Web Client:
1. Goto the Data Explorer area of the Web Client.

Example On- http://ServerName/Axiom/DataExplorer

Premise URL Where ServerName is the name of the Axiom Application Server, and Axiom

is the default name of the virtual directory.
Example Cloud https://CustomerName.axiom.cloud/DataExplorer

System URL Where CustomerName is the name of your cloud service system.

Alternatively, you can go to the Axiom Software launch page and click the Data Explorer icon.

2. Inthetop right-hand corner of the Data Explorer page, click New Data Explorer.

=NREN X
e @ nttp:/ /WA Aviom/dataexplorer P~ H © Data Explorers ‘ | A AT
File Edit View Favorites Tools Help [C“CK here to \
H create a new B
F hunts
Axiom Data Explorers Data Explorer ? @ ) whunter
fotders | @ = Qserch %
10 items
la lay 7] Ia 7] la la la 7]
;2 ;2 bz iz ;2 2 ] ;2 0z
Actuals Original Actuals Budget Ryan Actuals Ryan Budget demo Actuzls_calculation Test Data Test

3. Inthe New Data Explorer dialog, select the data set that you want to use with the Data Explorer,
and then click OK.

Data sets are user-defined collections of tables and columns. The data set determines the available
data for the Data Explorer session.

If no data sets are defined in your system, a message box informs you that one must be created
before you can use the Data Explorer. If you have the appropriate permissions, you can log into
the Excel Client or the Windows Client and create a new data set. Otherwise, contact your system
administrator for assistance.
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The new Data Explorer opens in the current tab. The available fields are the fields allowed by the selected
data set. You can now work with this Data Explorer as desired.

Opening a saved Data Explorer

Once a Data Explorer has been saved, you can access it from either the Excel Client or Windows Client, or
directly from the Web Client. Regardless of which client you use to open the file, the Data Explorer will
open in the Web Client.

When a saved Data Explorer is opened, it uses the query settings from when it was last saved. You can
then modify the query settings as desired for the current session. When you are done, you can close the
Data Explorer without saving (thereby leaving the saved settings intact), or you can save the Data
Explorer with your revised settings, or you can save a copy of the Data Explorer with the new settings.

To open a Data Explorer in the Excel Client or Windows Client:

In the Excel Client and Windows Client, Data Explorer files are saved in the Reports Library and can be
accessed like other reports—such as by using the Reports menu on the ribbon, or by using the Explorer

task pane. Data Explorer files are differentiated from other report files by use of the Data Explorer icon UK

If you are an administrator and you want to test a Data Explorer using different user permissions, you
can open a Data Explorer as a different user from the Excel Client or the Windows Client. To do so, right-
click the file in the Explorer task pane and then choose Open (as other user).

To open a Data Explorer in the Web Client:
In the Web Client, you can open saved Data Explorer files from the following location:

Example On- http://ServerName/Axiom/DataExplorer

Premise URL Where ServerName is the name of the Axiom Application Server, and Axiom

is the default name of the virtual directory.
Example Cloud https://CustomerName.axiom.cloud/DataExplorer

System URL Where CustomerName is the name of your cloud service system.

Alternatively, you can go to the Axiom Software launch page and click the Data Explorer icon.

From this page you can:
o Usethe All view to see all Data Explorer files that you have permission to access.
o Usethe Folders view to browse Data Explorer files by folder in the Reports Library.

o Usethe Search box to find Data Explorer files based on their name.

When viewing lists of Data Explorers, you can switch between Icon View and Detail View. To open a Data
Explorer from this location, click it.
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Viewing data in the Data Explorer

Using the Data Explorer, you can perform drag-and-drop analysis on your Axiom Software data. To view
data, you drag values and dimensions from the Available Fields to the query settings at the top of the
screen.

See the topics in this section for full details on querying and viewing data in the Data Explorer.

Data Explorer overview

The Data Explorer works by simplifying data into two categories, values and dimensions.

o Values are the data values that you want to report on, such as budget data for the first quarter, or
actuals data for last year.

e Dimensions represent how you want that data grouped and displayed. For example, do you want
to see budget data by account or department, or by groupings such as category, company,
region, VP, etc.?

To query data, you can drag and drop values into the Values box, and a dimension into the Rows box.
This will populate the data grid with the specified values, grouped by the row dimension. You can
optionally make the query more sophisticated by placing a dimension in the columns, or by using
multiple row dimensions, or by defining a filter.

TIP: You can also drag and drop values and dimensions directly into the appropriate zones of the
grid. When you drag a field over the grid, shading will indicate whether you are dropping the field into
the rows, columns, or values zone. The shading is green if the field is eligible to be placed there, and
red if it is not. Once a field is dropped, the query is refreshed and the field is added to the appropriate
query box.

To remove a field from one of the query boxes, click the X button for that field. You can also drag and
drop a field from one query box to another (as long as the field is eligible to be placed in that box), such
as dragging a dimension from Rows to Columns. If you drag a field from any query box to the Filter box,
then a copy is placed in the Filter box so that you can filter based on that field (leaving the original field in
place).

The following is a summary of each section of the Data Explorer:
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Item Description

Available Fields Displays the available values and dimensions that can be queried in this Data
Explorer.

The available fields are determined by the selected data set for the Data
Explorer. The data set is assigned when the Data Explorer is created, and cannot
be subsequently changed (although the data set itself can be edited to include
or exclude fields, which will be reflected in Data Explorers that use that data set).

Each field in this section displays with the following:

e Anicon that indicates whether the field is a key column or a non-key column
(key columns have a key icon).

« The name of the field (using either the actual column name or the display
name if defined).

o Thetable name that the field belongs to, in parentheses.

Values Defines the data values that you want to display in the Data Explorer. You can
place one or more value fields in this box.

Users who are familiar with Axiom query construction can think of this as the
data columns that you would place in the field definition for the query.

Dimension fields cannot be placed in the Values box.

Rows Defines the grouping level for the rows. The most common use case is to place a
single dimension field in this box, which results in one row per item in the
specified dimension. However, it is possible to group the rows by multiple
dimensions.

Users who are familiar with Axiom query construction can think of this as the
"sum by" level for the query.

Value fields cannot be placed in the Row box.

Columns Optional. Defines the grouping level for the columns. You can place a single
dimension field in this box, which results in one column per item in the specified
dimension, showing the values from the specified value field.

Users who are familiar with Axiom query construction can think of this as placing
column filters in the field definition.

Value fields cannot be placed in the Columns box.

Filters Optional. Filters the data returned by the query. You can place one or more
value fields and/or dimension fields in this box to filter by those fields.

Users who are familiar with Axiom query construction can think of this as
defining a data filter for the query.
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Defining the data query for the Data Explorer
The data query for the Data Explorer is defined by doing the following:

o Place one or more Value fields in the Values box to define the columns of data for the query. You
can also define custom value fields for calculations.
o Place one or more Dimension fields in the Rows box to define the grouping level for the rows.

o Optional. Place a single Dimension field in the Columns box if you want the column data to be
grouped by a dimension.

For example, if you want to view Q4 data by account, you would place the Q4 value field in the Values
box and the Acct dimension field in the Rows box. If instead you want to view all four quarters of data,
you would place the value fields Q1, Q2, Q3, and Q4 in the Values box.

G | @ hitp:/fwhga/axiom/ dataexplorer/config?data @ ~ & || & Untitled | ‘

File Edit View Favorites Tools Help

. * a

Untitled W] i3 @ L whunter

Available Fields Values + Rows Columns Filters
Drop o dimension here to group across the Drop @ fieid here to filter.

Values ‘q:v x”azv xHasv x| |ACCT x| o grean 7o 4

M CUR(GL2012) )

i Q1 (5L2012) 2 ‘tuv % |

[ 02 (6L2012)

[ 03 (6L2012)

[ Q4 (6L2012) B | @ o= i)

[ TOT (6L2012)

i YTD (GL2012) ACCT ACCT T | GL2012.01 T | GL2012.02 Y GL2012.03 Y GL201204 T

[ vTp1(GL2012) 1000 6,552,796 1,976,862 -2,707,507 2066912

[ YTD10 (GL2012)

1100 30 17 -14,596 -45

[# ¥TD11 (GL2012)
[# ¥TD12 (GL2012) 1300 3,554,649 1,946,693 760,235 5,052,648
[ ¥TD2 (GL2012)

v 1400 172,844 -192,173 6,378 -402,286
{ YTD3 (GL2012)
1600 -2,645 31,823 -128,336 -24,101
Dimensions
9 ACCT (ACCT) 1700 -2,516,934 49,544 -36,004 -17,771
[ Description (ACCT) 1800 0 a a o
[ Category (ACCT)
1800 -451,857 3,314 -122 -486,149
§ DEPT (DEPT)
[ Description [DEPT) 2000 -479,245 54,944 41,923 81,354
HH World Region (DEPT)
2100 -126,524 302,909 -15,307,689 762,516
[ Country (DEPT)
[ Region (DEPT) 2200 -538,735 -658,820 14,187,167 -104,681
@@ vp (DEPT) 2300 0 3739 0 0
[ Manager (DEPT) v
2400 115,506 -199,858 -828,221 762,874
71,238,022 55,335,632 53,809,942 69,723,671

Example Data Explorer with values and rows defined (click to view full size)

You can also filter the data for the query using the Filter box. For more information, see Filtering data in
the Data Explorer.
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NOTE: If the available fields for the Data Explorer come from multiple tables, then fields may
dynamically become hidden in the Available Fields area depending on whether they are compatible
with what you have already placed in the query settings. If placing a field in the query settings would
result in an invalid query, then that field is hidden and will not become available until the query
settings are changed to a state that would allow that field.

Defining values

The Values box defines the columns of data for the query. You can drag and drop one or more value field
into this box.

Typically, the minimum query will have at least one value field and at least one row dimension. Although
it is possible to define only values, this will return the entire summarized value for the value field, which is
of limited use. For example, if you place a Q4 value field in the Values box and do not define a row
dimension, the Data Explorer will display the sum of all values for Q4, for all departments and all accounts
(or for whichever dimensions are being used by your system). You must define a row dimension in order
to summarize the data at a meaningful level, such as per department or per account, or by a grouping
such as category, region, VP, etc.

If desired, you can also define custom value fields for calculations, such as a variance field. For more
information, see Defining calculations in the Data Explorer.

NOTE: The order of fields in the Values box defines the order of columns displayed in the Data
Explorer. Currently, you cannot drag and drop fields within a box to change the order. If you want to
change the order, you will need to delete and then re-add the fields in the desired order.

Defining rows

The Rows box defines the grouping level for the rows of the query. You can drag and drop one or more
dimension fields into this box. For example, if you want each row to display data for a particular
department, then the row dimension should be DEPT.

Most queries will have just one row dimension. If desired, you can place multiple row dimensions to
group the data by both dimensions. For example, if you define Dept and Acct as your row dimensions,
then you will have one row for each unique account/department combination.

When using multiple row dimensions, you also have the option to subtotal the data by dimension. For
more information, see Subtotaling data by a dimension in the Data Explorer

User Guide Axiom Software | 102



NOTES:

« Only 5000 rows can be displayed in the Data Explorer (grid view). If your row dimension
settings result in more than 5000 rows, a warning displays at the top of the Data Explorer to let
you know that not all of your data is being displayed. If this occurs, you should define a filter

to limit the data to a smaller number of rows.

o The order of fields in the Rows box (if using multiple row dimensions) defines the order of the
dimension columns displayed in the Data Explorer. Currently, you cannot drag and drop fields
within a box to change the order. If you want to change the order, you will need to delete and
then re-add the fields in the desired order.

Defining columns

The Columns box is only used if you want the columns in the Data Explorer to show the Values data by a
dimension. You can drag and drop a single dimension value into this box. This causes the value field in
the Values box to be "split" so that you now have one column of data per dimension item.

For example, imagine you have Q4 as the Values and Acct as the Rows. This means you have one row per
account, and one column of data showing the Q4 values for each account. Now imagine that you place
the Region dimension in the Columns box. The rows remain the same, but now you could have six
columns of data, each one showing the Q4 data for a particular region.
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Example Data Explorer with columns defined

Typically, the Columns box is used along with both the Values and Rows boxes. However, it is possible to
use just the Values and Columns boxes, to "flip" the presentation of a simple query. For example, if you
put Q4 in the Values box and Regions in the Columns box (with no row dimension defined), then this is
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effectively the same as putting Regions in the Row box, except that now you will have the regions data
going across the columns instead of down the rows.

NOTES:
e Only one column dimension can be defined at a time. If you have defined a column dimension
and now you want to change that dimension, you must delete the current dimension first and
then drag and drop a new dimension into the Columns box.

e Only 100 columns can be displayed in the Data Explorer (grid view). If your column dimension
and values settings exceed 100 columns, a warning displays at the top of the Data Explorer to
let you know that not all of your data is being displayed. If this occurs, you should either
decrease the number of value fields or define a filter to limit the number of dimension columns
(or both).

o Typically, if you define a column dimension then you only use one field in the Values box.
Although you can use column dimensions with multiple value fields, the number of columns in
the Data Explorer will start increasing rapidly because you will have one column per dimension
for each value field. For example, if you have six regions and three value fields, that is 18
columns of data.

Filtering data in the Data Explorer

You can define afilter to limit the data shown in the Data Explorer. Filters can be based on Values or
Dimensions from the list of Available Fields.

The filter is applied as part of the overall query to the database, similar to a data filter defined for an
Axiom query. If you want to filter values after the query is made, you can do this on the individual display
columns (when in grid view).

To apply a filter, drag and drop one or more fields into the Filter box. Then click the down arrow button
to define the parameters of the filter. The available parameters depend on whether the field is a
dimension or a value. See the sections below for more details.

NOTES:
« Ifyou define a multi-field filter, then the filter for each field is concatenated using AND
(meaning a value must meet all filters in order to be included). Currently there is no option to
specify OR behavior instead.

« Your data query settings impact which fields are currently valid to be used in the Filter box. If a
field is not currently valid, you will not be able to drag and drop it into the Filter box.

Dimension filters

The available options for dimension filters depend on the number of elements in the dimension.
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If the dimension has 100 elements or less, then you can define a filter using check boxes to indicate which
dimension elements to include in the data query. Any dimension element that is left unchecked will be
filtered out. By default, all elements are selected.

Filters

Category x

=8
=
=
=
5

@ Balance Sheet
W] cocs
E Marketing
@ Other Expenses
i E Other Income/Expense
@ Owerhead
E Payroll A
@ Revenue
@ Statistic
E Taxes B

E Trawvel

| OK || Cancel 1

If the dimension has more than 100 elements, then you can set the filter by typing a value and then using
operators such as equals / not equals, or greater than / less than. For example, you might specify that
you want to see all departments greater than 5000.

NOTE: The number of dimension elements listed in the filter is limited to the dimensions used by the
inferred primary table for the query. For example, you might be filtering by Company and there are
10 unique company values. But if your value fields are from the GL2018 table and only 6 companies
are represented in that table, then only 6 companies will be available to the filter.

Filters

|DEFTT' x ‘

greaterthan K4
5000 |

| oK || Cancel |
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This option offers the operators In and Not In. You can use this to enter multiple dimension elements to
include or exclude. For example, imagine that you want to see the data for three specific departments in
the Data Explorer. You can define a filter using In and then enter a comma-separated list of the
departments to include.

Filters

|DEPTT x |

141000,42000,44000 |

| 0K || Cancel |

Value filters

For value fields, you can set the filter by typing a value and then using operators such as equals / not
equals, or greater than / less than. This uses the same options as described above for dimension filters
with more than 100 elements.

NOTES:
¢ Calculations added to the Values box cannot be used to filter data.

o Ifyou are querying data from multiple data tables, value fields from those individual tables
cannot be used to filter data.

Defining calculations in the Data Explorer

In addition to displaying one or more value fields, you may also want the Data Explorer to display the
result of a calculation. For example, you may be displaying YTD budget data and YTD actuals data, and
you also want to display the difference between the two and/or the variance percentage. You can create
user-defined calculations which will display as additional columns in the Data Explorer grid.

Calculations support addition, subtraction, multiplication, and division. You can create compound
statements with multiple operators, for example to create a variance percentage calculation.

NOTE: If a calculation results in a "divide by zero" error, the result of that calculation is displayed as
zero. No error displays in the Data Explorer, but an error is logged to the Web Client log.

In order to create or edit a calculation, the value fields that you want to use in the calculation must
already be placed in the Values box. If you want to use a field in a calculation but not display the field in
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the Data Explorer, you can adjust the display properties of that field so that it is hidden (see Formatting
values in the Data Explorer).

To create a calculation:

1. Click the plusicon in the header of the Values box.

Values @

|'|"-|:f'|""'Ir X||TDTT x|

The Calculation dialog opens.

2. Inthe Name box, define a name for the calculation. This name will display as the column title for
the calculation.

3. Usethe Available fields and Available operators to construct a calculation within the Formula
box.
o To add afield or an operator to the Formula box, click the desired item.

e You can also manually type the calculation in the Formula box. However, any value field
that you manually type into the box must be present in the Available fields.

e You can use parentheses to construct compound calculations.

The following example shows a simple difference calculation, where one field is subtracted from
the other field.
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Calculation X

Name:
|Diﬁerence

Available fields:
TOT (GL2012TOT) TOT (GL2013.TOT)

Available operators:
+ = (%] r ][ }

Formula:
GLZ013.TOT - GLZ01Z.TOT

Format: Number v Aggregation: sum v

Decimals: [0 |

0K || Cancel

4. Set the formatting options as desired for the calculation. For more information on these options,
see Formatting values in the Data Explorer.

Calculations support an additional aggregation option of Apply Formula. This means that the
"total" value of the calculation column will be calculated by applying the formula to the total row
(as opposed to summing all the values in the column, for example).

For some basic calculations, using the default aggregation of Sum will return the same result as
Apply Formula. However for other calculations, such as those involving division and
multiplication, you will want to change the aggregation to Apply Formula.

5. Click OK to create the calculation.

The calculation now displays in the Values box, and in the Data Explorer grid (assuming that is the current
view). It will also display in chart views if the query data is valid for that chart type.

Calculations are only saved within the Data Explorer file; they are not part of the data set. If you want the
calculation to be available the next time you use the Data Explorer, you must save the file.
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Editing and deleting calculations

You can edit calculations like any other value field, by clicking the down arrow next to the field name in
the Values box. You can then edit any of the settings in the Calculation dialog.

You can delete a calculation by clicking the X next to the field name in the Values box. Keep in mind that if
a calculation is deleted, there is no way to get it back other than exiting out of the current file and
opening a saved version of the file that contains the calculation.

Formatting values in the Data Explorer

You can format the display of values in Value fields. The following properties can be controlled:
o Theformat of the value, either number or percent
o The aggregation method for the automatically generated total and subtotal rows, for this field
o The number of decimal places to display

o Whether the field should be hidden in the data view (does not apply to user-defined calculations
which are always displayed)

By default, values are displayed as numbers with zero decimal places. The default aggregation method
for the total is sum.

The formatting options do not apply to any non-decimal fields, such as string fields, except for the option
to hide the field.

To define the format of a value field:
1. Click the down arrow next to the field name in the Value box. For example:

Values =
|ME {Ex |
Format: Number v
Aggregation: | gy, v
Decimals: E

(] Hide column in output

| QK || Cancel |

For user-defined calculations, click the Edit icon next to the field name to define formatting
options for the calculation. For example:
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Difference [# X |

2. Modify the formatting options as desired:

Item Description

Format Select Number (default) or Percent.

Aggregation Select the desired aggregation method to use for this field in the
automatically generated total row (and subtotal rows, if applicable). You
can choose:

Sum (default): Displays the sum of all values in the column.
Count: Displays the count of all values in the column.

Min: Displays the minimum value in the column.

Max: Displays the maximum value in the column.
Average: Displays the average of all values in the column.

Apply Formula: Uses the defined calculation on the total/subtotal row
instead of aggregating the values. This option is only available for user-
defined calculations. See Defining calculations in the Data Explorer.

Total and subtotal rows are only generated for decimal-type columns.
Calculations are treated as decimal type.

Decimals Enter the number of decimal places to display for the values in the column.

Hide column in Select this check box if you do not want to display the field in the data
output view.

You might use this if you want to use the field in a user-defined calculation,
but you do not need to see the field in the data view.

This option is not available for user-defined calculations.

3. Click OK to apply your changes.

Format settings can only be saved per Data Explorer file. If you want to retain your format changes for
this Data Explorer instance, you must save the file.

Subtotaling data by a dimension in the Data Explorer

You can place more than one dimension field in the Rows box, to display the data using multiple
dimensions. By default, each row in the Data Explorer will be grouped by all dimension fields (similar to
using two or more fields in the "sum by" of an Axiom query). For example, if you define Dept and Acct as
your row dimensions, then you will have one row for each unique account/department combination.

If desired, you can define subtotal groupings using one or more of your defined row dimensions, by
dragging and dropping a column header to the top of the data grid. This additional grouping area is only
available when the Rows box contains at least two dimension fields.
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Drag a column header and drop it here to group by that column
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For example, imagine that you want to display department data, grouped and subtotaled by World
Region. You would place both World Region and Dept into the Rows box, and then you would drag and
drop the World Region column header to the top of the grid. The data now displays as shown in the
following screenshot, using collapsible groupings:
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984,719
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4,907,438
994,237
5,732,100
1,259,360
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~
3,334,781 -8,747,346
175,115 352,727
320,618 664,102
125,532 -446,856
4,782,736 -10,665,627
187,900 276,691
1,600,161 8,618,302
3,318 -3,862
10,530,161 -29,775,513
1,371,001 3,536,437
218,339 775,898
1,520,523 4,211,577
369,474 -889,885
246 -50,204

747,930 11,541,390
72,045,898 -184,382,873

You can change the sort order of the grouping blocks by clicking the dimension field in the grouping
header. To remove the grouping blocks, click the X to the right of the dimension name.

Data that is grouped and subtotaled in this way cannot be exported to a spreadsheet.
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Changing the data view for the Data Explorer

You can view the data in the Data Explorer using several different views. By default, the view is a grid-style
view. To change the data view, click one of the view buttons above the data display area.

Values + Rows
|TGT""’ x||TﬂT‘F X||Dr‘ﬂrerence§‘ x| |DEFT x|
H || @ | >
DEPT.DEPT L2012 TOT
20000

Grid view

This view displays the requested data in a grid. This is the default view for the Data Explorer.

o Datais displayed in a column/row grid based on the data query settings. The first column(s)
display the row dimension(s), followed by one or more value columns (optionally broken out by
the column dimension). Value columns are displayed in the order they are listed in the Values box.
Each value column has a subtotal.

e You can sorton acolumn in the grid by clicking the column header.

o You can filter on a column in the grid by clicking the down arrow in the column header. When
filtering in this view, you can define up to two filter statements using equals / not equals or greater
than / less than, and you can specify whether to use AND or OR to concatenate those filters. This
filter simply changes what is displayed in the Data Explorer, it does not affect the query to the
database.

The grid view is limited to displaying up to 5000 rows and up to 100 columns. If your data query exceeds
this, a warning message displays at the top of the screen. You can define a filter to limit the data to the
visible parameters.

Column chart

This view displays the requested data in an automatically generated column chart. Currently the chart
does not have any options to change its display or configuration.
o By default, the X-axis of the chart uses the row dimension. If no row dimension is defined but a
column dimension is defined, then it will use the column dimension. If no row or column
dimension is defined, then it will use the value field(s).
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o The Y-axis of the chart is automatically generated based on the values in the data query. The
columns will show either one or more value fields per row dimension, or all column dimensions
per row element (if a column dimension is defined).

e The column chart is not available as a view option if multiple row dimensions are defined, orifa
column dimension is used with multiple value fields.

The column chart view is limited to displaying up to 100 rows and up to 100 columns. If your data query
exceeds this, no chart will display. You can define a filter to limit the data to the visible parameters.

Pie chart

This view displays the requested data in an automatically generated pie chart. Currently the chart does
not have any options to change its display or configuration.

o Each piesslice represents the value of an item in the row dimension (or the column dimension if no
row dimension is defined).

o The pie chart is only available for configurations that consist of one defined dimension (either row
or column) and one defined value field.

The pie chart view is limited to displaying up to 100 rows and up to 100 columns. If your data query
exceeds this, no chart will display. You can define a filter to limit the data to the visible parameters.

Line chart

This view displays the requested data in an automatically generated line chart. Currently the chart does
not have any options to change its display or configuration.

The rules for the line chart are the same as the rules for the column chart.

The line chart view is limited to displaying up to 100 rows and up to 100 columns. If your data query
exceeds this, no chart will display. You can define a filter to limit the data to the visible parameters.

Exporting data to a spreadsheet from the Data Explorer

When you are in grid view, you have the option to export the current data to an Excel spreadsheet file.
This exports the data shown in the grid, including column headers.

To export the data, click the Export Grid to Excel button located above the grid, on the right side. Follow
the browser prompts to save the XLSX file to your desired location. By default, the name of the file is the
name of the Data Explorer file (if saved as a file).

This exported data is static and disconnected from Axiom Software. It cannot be subsequently updated.
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Saving a Data Explorer

You can save a Data Explorer session for your future use, or to share with other Axiom Software users.
Data Explorers are saved as a special file type within the Reports Library.

When you save a Data Explorer, the current query settings are saved as a starting point. The next time
the file is opened, it will start with the saved settings for Value, Row, Column, and Filter. You can change
these settings as desired to perform further analysis in the current session. You can then close the file
without saving the setting changes, or you can save the file to set a different "starting point" for the file.
You can also save a copy of the file with these new settings.

NOTE: The selected view is not saved; when a Data Explorer is opened the data is always shown in
grid view.

Access to Data Explorer files is controlled just like any other file in the Reports Library, using the file
permission settings defined for the folder or the file in security.

Saving a new Data Explorer

Use the Save As button Hdl in the top right-hand corner to save a new Data Explorer, or to save a copy
of an existing Data Explorer.

In the Save As dialog, navigate to the folder where you want to save the file, and type a file name. Click
Save to save thefile.

Saving an existing Data Explorer

Use the Save button H in the top right-hand corner to save the current Data Explorer. The file will be
saved using the current Data Explorer settings.
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Word and PowerPoint Integration

Axiom Software offers integration with Microsoft Word and PowerPoint, so that you can:

« Easily maintain Word and PowerPoint files that are stored within the Axiom database. These files
can be directly opened, edited, and then saved back to the Axiom database without needing to

export and re-import the files. You can also save new files to the Axiom database from Word or
PowerPoint.

o Display Axiom data within PowerPoint presentations using Axiom forms. These forms can be live

(requiring login to Axiom Software) or disconnected. When using disconnected forms, you can
update these forms as needed from within PowerPoint.

This integration is provided using an Axiom add-in for Word and for PowerPoint. Axiom security applies
to all files opened using this add-in. The user must have read access in order to open a file using the add-
in, and the user must have read/write access in order to edit and save a file using this add-in.

The add-in displays as an Axiom tab within Word or PowerPoint. The tab displays on the right-hand side
of the ribbon, after the standard Word or PowerPoint tabs but before any special context-sensitive tabs.

®
E Home Insert Design Transitions Animations Slide Show Review View Axiom

SkhH & D2 a8 @

Open  Save Axiom Options | Add Live  Add Update Help
- h Lagin Form Snapshot Snapshots -

File Options Axiom EPM Axiom Forms Help

Example add-in

Installing the Word or PowerPoint add-in

There are two ways to install the Word and PowerPoint add-ins:
o You can install either add-in directly from the Axiom Software administration web page.

e The Word and PowerPoint add-ins are installed automatically the first time that you open an
editable Word or PowerPoint file that is stored within the Axiom database.

Each add-in is installed separately. You can install the PowerPoint add-in without installing the Word add-
in and vice versa.
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Once the add-in is installed, it will remain active within your Word or PowerPoint installation, so that you
can now open files that are stored in the Axiom database directly from within Word or PowerPoint.

Installation prerequisites and requirements

o Asupported version of Microsoft PowerPoint or Microsoft Word must be installed on your
computer. For more information on supported versions, see the separate Technical Requirements
document.

o Microsoft Visual Studio Tools for Office (VSTO) must be present on your computer in order to
install the add-in. This means that by default, the add-in is only supported for use with the Axiom
Excel Client, because VSTO is a prerequisite for the Excel Client. However, if you want to use the
add-in with the Axiom Windows Client, you can install VSTO on machines where you want the add-
in to be available.

NOTE: There is a known incompatibility with the Axiom Software add-in for PowerPoint and the
Camtasia add-in for PowerPoint. If you have the Camtasia add-in installed, the Axiom add-in will not
release locks on files as expected. In this case you will need to disable the Camtasia add-in if you want
to use the Axiom add-in. It is possible that other third-party PowerPoint add-ins may have similar
issues.

Installing the add-in automatically
The following summarizes the installation process when the add-in is installed automatically.

o Loginto the Axiom Excel Client, and use any means to open a Word or PowerPoint file for which
you have read/write permission. If you are using the Windows Client and you have explicitly
installed VSTO for use with this add-in, then you can alternatively perform this step in the
Windows Client.

For example, you can use Axiom Explorer, the Explorer task pane, or the Reports Library dialog—
anywhere that you can access and open a Word or PowerPoint file.

o Microsoft Word or PowerPoint opens to display your file. You should now see an Axiom tab in the
Word or PowerPoint ribbon. You can edit your file as desired, and when you save, the file will be
updated in the Axiom file system.

« The Axiom tab will persist in your Word or PowerPoint installation from this point forward.
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Installing the add-in manually

You can install the add-in manually as needed from the Axiom Software administration web page. You
might use this approach if you want to use the embedded Axiom form features for PowerPoint and you
don't typically work with PowerPoint files that are stored in the Axiom database.

o Go to the Axiom Software launch page. By default the URL is as follows:

Example On- http://ServerName/Axiom/home/launchpage

Premise URL Where ServerName is the name of the Axiom Application Server, and Axiom

is the default name of the virtual directory.

Example Cloud https://CustomerName.axiom.cloud/home/launchpage

System URL Where CustomerName is the name of your cloud service system.

Contact your system administrator if you do not know the appropriate URL for your environment.
¢ Click the link to Install/Launch Axiom PowerPoint Add-in or Install/Launch Axiom Word Add-in.

e When prompted, log into Axiom Software. Note that you may not be prompted to log in if you are
using Windows User Authentication and you have previously enabled Remember Me for the
desktop client.

e Onceyou have logged into Axiom, Microsoft Word or PowerPoint opens. You should now see an
Axiom tab in the Word or PowerPoint ribbon. The Axiom tab will persist in your Word or
PowerPoint installation from this point forward.

Upgrading the add-in
Once the add-in is installed, it will be upgraded as part of upgrading your Axiom Desktop Client
installation. A version mismatch may occur if your Axiom Application Server is upgraded, and you run the
Word or PowerPoint add-in before you access and upgrade your Axiom Client. In that case you can
simply close the add-in, upgrade your Axiom Desktop Client, and then access the add-in again.

Logging into Axiom Software from Word or PowerPoint

When you open a Word or PowerPoint file from within Axiom Software, the Word or PowerPoint add-in
automatically considers you as logged into that system. You do not need to explicitly tell the add-in that
you want to use the current system, and there is no additional action necessary to log in.

However, you can also log in to Axiom Software from within Word or PowerPoint, for purposes of
opening Word or PowerPoint files that are stored within the Axiom database, or to save new files to the
Axiom database. In this circumstance you have several options regarding the login behavior.
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Logging into Axiom Software

If you use the Open or Save features on the Axiom tab, and you are not already logged into Axiom
Software, then the add-in will attempt to log you in.

e The add-in will use the Axiom Application Server designated as the Active server for the add-in. By
default, this is the application server for the system that you were logged into when the add-in
was first installed. You can change the active application server using the Options button on the
Axiom tab.

o The Axiom Software login screen may or may not display, depending on the authentication type
and configuration used at your organization. Generally speaking, the login behavior will be the
same as when you log in to Axiom Software directly.

o Ifthelogin is successful, then the Open or Save process will continue, and you will remain logged
into the current Axiom Software system until you close Word or PowerPoint, or until you use the
Logout button for the add-in to log out.

If desired, you can log in directly using the Axiom Login button on the Axiom tab. As with the automatic
login, the add-in will use the Axiom Application Server designated as the Active server for the add-in. The
login behavior is the same.

Logging out of Axiom Software

To log out of the current Axiom Software system, click the Log Out button on the Axiom tab. (The Login
button becomes the Logout button after you have logged in.) If you have any Axiom-managed files
opened from that system, you will be prompted to save them before the logout occurs.

NOTE: If you log out of the Word or PowerPoint add-in, this may clear your "remembered" status for
the Excel and Windows Clients. This only applies if you are using Windows User Authentication and
only if you are not also currently logged into the Excel or Windows Client at the time you log out.

Changing the active Axiom Software system for the add-in

By default, whenever you log into Axiom Software from within Word or PowerPoint, the add-in uses the
active Axiom Application Server as specified in the add-in Options. If you want to change the active Axiom
Application Server:

1. Logoutofthe current Axiom Software system (if applicable).

2. Click the Options button on the Axiom tab, and then select the desired application server from the
Active server drop-down list.

You will now connect to the newly selected application server whenever you log into Axiom Software
from within Word or Power Point, until you change the setting.

This behavior only applies when logging into Axiom Software from within Word or PowerPoint. When
you open a Word or PowerPoint file from within Axiom Software, then the add-in always considers you
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logged into the application server for that system, regardless of what is specified as the active application
server for the add-in.

Managing available Axiom systems

Whenever you open a Word or PowerPoint file from within Axiom Software, that application server is
automatically added to the list of available application servers for the add-in. If desired, you can manually
add application servers or delete application servers as follows:

1. Ifyou are currently logged into a system, click the Log Out button on the Axiom tab. You must be
logged out to manage the list of servers.
2. Click the Options button on the Axiom tab.

3. Inthe Axiom Software Options dialog, click Manage servers.

4, Add or delete a server as follows:
o To delete a server, select the server in the list and click the Delete button <.

o To add aserver, click the Add button *. In the Add Application Server dialog, type the URI
to the application server (for example: http://servername/Axiom).

This list is managed separately for each add-in (Word and PowerPoint).

Opening Word and PowerPoint files

Once the Word or PowerPoint add-in has been installed on your computer, you can open Word or
PowerPoint files that are stored in the Axiom Software database in either of the following ways:

o You can open the files from within Axiom Software, using features such as Axiom Explorer, the
Explorer task pane, etc.

o You can open the files from within Word or PowerPoint, using the Axiom tab on the Word or
PowerPoint ribbon.

To open a file stored in the Axiom database from Word or PowerPoint:
1. Onthe Axiom tab on the Word or PowerPoint ribbon, click Open.

2. Ifyou are not already logged in to Axiom Software, then the Axiom add-in will attempt to log you
in, using the active Axiom Application Server as defined in the Axiom add-in Options. By default,
this is the application server that you were logged into when the add-in was first installed. For
more information, see Logging into Axiom Software from Word or PowerPoint.

Once you are logged in, the Axiom Explorer dialog opens.
3. Navigate to the file that you want to open, then click Open.

In this context, the Axiom Explorer dialog only shows locations that allow saving Word or
PowerPoint files, such as the Reports Library. Additionally, the dialog is filtered to only show file
types for the current program (for example, only .DOC or .DOCX files if you are in Word).
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Your Axiom security permissions are applied as normal to determine which files you can see and
your level of access rights to those files.

The selected file opens in Word or PowerPoint as either read-only or read/write, depending on your
permissions to that file.

Saving Word and PowerPoint files

If you open an Axiom-managed file in Word or PowerPoint with read/write permissions, then when you
save that file, the Axiom database will be updated directly with the latest copy of that file.

To save a file from Word or PowerPoint:

e On the Axiom tab on the Word or PowerPoint ribbon, click Save.

The file will also be saved in the Axiom database if you use any of the native Word or PowerPoint
methods for saving—such as clicking Save in the Quick Access toolbar, or using CTRL+S. Basically, if the
file is an Axiom-managed file and you remain logged into Axiom Software (via the add-in), any save
process in Word or PowerPoint will update the file in the Axiom database.

You can also perform the following save actions for the Word or PowerPoint file:
o To save a copy of the file locally (as a non-managed file), click the down arrow below the Save icon,
then click Save As (Local File).

This will create a local copy of the file to your specified save location. Any further updates to the
file will not be saved in the Axiom database.

o To save a copy of the file to the Axiom database (as a new file), click the down arrow below the
Save icon, then click Save As (Repository). You can also use the native File > Save As command in
Word or PowerPoint.

This will open Axiom Explorer so that you can save a copy of the file to a location where you have
read/write rights.

Saving a read-only managed file

If you have an Axiom-managed Word or PowerPoint file open as read-only, then when you click Save the
Axiom Software Save As dialog will open, so that you can save the file with another name or to a different
location in the Axiom Software file system.

If you would rather save a copy of the file locally, click the down arrow below the Save icon on the Axiom
tab, then click Save As (Local File).

Saving a local file to the Axiom Software database

If you have a local (non-managed) file open that you want to save to the Axiom Software database, click
the down arrow below the Save icon on the Axiom tab, then click Save As (Repository).
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Displaying Axiom data in PowerPoint files

You can display Axiom data within a PowerPoint file using an Axiom form. Once the Axiom form is set up
to display the data you want, you can embed it within the PowerPoint file to show as part of the
presentation. There are two options to embed the Axiom form:

o Snapshot: You can embed a snapshot (MHT file) of an Axiom form into a PowerPoint slide. The
snapshot is a disconnected file that can be displayed in a PowerPoint presentation without
requiring a live connection to Axiom Software. You can later update form snapshots from within
PowerPoint to refresh them with the latest data from Axiom Software as needed.

o Live Form: You can embed a live Axiom form into a PowerPoint slide. This requires a live
connection to Axiom Software to display the form within the PowerPoint presentation. This
approach behaves as if the PowerPoint slide contains a web browser that is connected to the
Axiom Software Web Client. You can change options in the form and refresh it on-the-fly from
within the presentation.

The Axiom add-in for PowerPoint provides the means to embed either a snapshot or a live Axiom form
into a PowerPoint file. You can embed the form in any PowerPoint file—the PowerPoint file does not
need to reside in the Axiom database.

Compatible PowerPoint versions

The ability to embed an Axiom form in a PowerPoint slide is fully supported for Microsoft PowerPoint
2010 only. In PowerPoint 2013, it is possible to use the feature if you manually edit the registry, per this
Microsoft KnowledgeBase article. Any change made to the registry for this purpose is at your own risk;
Axiom Software cannot recommend this change or assist with this process.

Using form snapshots in PowerPoint files

You can embed a snapshot (MHT file) of an Axiom form into a PowerPoint slide. The snapshotis a
disconnected file that can be displayed in a PowerPoint presentation without needing a live connection
to Axiom Software. As needed, you can update form snapshots from within PowerPoint to refresh them
with the latest data from Axiom Software.

Taking a snapshot of an Axiom form for use in PowerPoint

When you take a snapshot of an Axiom form, it consolidates all aspects of the web page into a single file
(the MHT file). Additionally, any interactive elements of the form are "frozen" as of the point of the
snapshot.

For example, if the form contains a drop-down list, the snapshot will be frozen at the currently selected
item in that list. The information about your selections is also stored in the snapshot, so that if you
subsequently update the snapshot via PowerPoint, your selections will be applied during the refresh.
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To take a form snapshot for use in PowerPoint:

1. Open the Axiom form in the Web Client (meaning open the file in a stand-alone browser, not as a
tab within the Excel Client or Windows Client).

TIP: If you are currently in the Excel Client or the Windows Client, you can open the form-
enabled file and then select Forms > Preview Form in Browser from the Axiom ribbon to open
it in the Web Client.

2. Configure any interactive elements in the Axiom form as desired, so that the snapshot will be
frozen in the appropriate state.

3. Hover your cursor over the top of the form to bring up the Web Client "curtain" menu, then select
Tools >Snapshot form.

4, Savethe MHT file to your desired location when prompted by your browser.

This MHT file is the file that you will embed into the PowerPoint slide.

Embedding a form snapshot into a PowerPoint slide

You can use the Axiom add-in for PowerPoint to embed the form snapshot into a PowerPoint slide. If this
add-in is not already installed, see Installing the Word or PowerPoint add-in.

1. Open the PowerPoint file in which you want to embed the snapshot, and navigate to the slide
where you want to place it. This can be any PowerPoint file; the PowerPoint file does not have to
be stored in the Axiom database.

IMPORTANT: Do not embed the snapshot in the first slide of the PowerPoint file. The
snapshot will not display as expected if it is located in the first slide.

2. Onthe Axiom tab, in the Axiom Forms group, click Add Snapshot.

3. Inthe Open dialog, navigate to the location where you saved the snapshot file (the MHT file), then
click Open.

A placeholder boxis added to the PowerPoint slide, displaying the name of the snapshot that you
embedded. You can move and resize this box as needed within the slide.

The contents of the snapshot do not display in "designer" mode within PowerPoint—you will only see
the placeholder box. The only time that you can view the snapshot contents is when playing the
PowerPoint slide show.

NOTE: You cannot manipulate the embedded snapshot in the PowerPoint slide while the slide show
is also playing. If you want to make a change to the placement or size of the embedded snapshot,
you should close the active slide show, make the change in the PowerPoint designer, and then
restart the slide show.

User Guide Axiom Software | 122



Updating an embedded snapshot in PowerPoint

You can update an embedded snapshot at any time. When you update a snapshot, Axiom Software
opens the source file for the snapshot on the Axiom Application Server, and submits the state of the
Axiom form as it was when you took the snapshot. The Axiom form is refreshed and the snapshot is
retaken with the updated data.

The following rules apply to updating snapshots:

o The user updating the snapshot must have at least read-only permission to the source file for the
snapshot. The snapshot will be updated using the Axiom security permissions of the updating
user, not of the user who originally took the snapshot. This means that the data in the snapshot
may be different if the updating user has differing permissions than the original user.

o The source file for the snapshot must still exist within the Axiom database. The connection is
based on the document ID, so it does not matter if the source file has been renamed or moved
within the Axiom file system.

o If new components have been added to the source file, those components will display in the
snapshot in their default state. If components have been deleted from the source file, those
components will be deleted from the snapshot.

o Existing components in the snapshot will be updated and modified to meet the current
configuration of the component within the source file (for example, if a component has been
resized in the source file then it will be resized in the snapshot).

o Ifan existing component has been modified to the point where its state in the snapshot is no
longer valid within the context of the source file—for example if you took the snapshot with a
particular selection in a combo box, and that selection is no longer valid in the source file—then no
error will occur but the snapshot may now contain blank components (which may in turn impact
the display of other components). In this case you should manually take a brand-new snapshot
rather than attempt to update the existing snapshot.

To update an embedded snapshot in PowerPoint:

1. Open the PowerPoint file in which you want to update snapshots.
2. Onthe Axiom tab, in the Axiom Forms group, click Update Snapshots.

If you are not already logged into Axiom Software, you will be prompted to log in.
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NOTES:

e You must log into the same system that the snapshot was taken from. If you log into a
different system, then an error will occur when attempting to update the snapshot. If
your default system is currently set to a different system than the source for the
snapshot, then you will need to log out of the current system and then use Options to
change systems. For more information see Logging into Axiom Software from Word or
PowerPoint.

e You can have snapshots from multiple systems within a single PowerPoint file. In this
case you must log into one system and perform Update Snapshot, then log into the
other system and perform Update Snapshot. As described above, you will get errors for
the snapshots that are not part of the current system, but those snapshots will be left
as is. The snapshots that belong to the current system will be updated as expected.

Axiom Software will attempt to update each embedded snapshot in the PowerPoint. A progress bar
displays the status of each snapshot update. If one of the snapshots cannot be updated, an error
message will result. You can dismiss the error and the update process will continue with the next
snapshot in the file (if applicable).

If a snapshot cannot be updated, it is left as is.

Behavior of the embedded snapshot when playing the PowerPoint slide show

The content of the snapshot is only visible when playing the PowerPoint slide show. While the slide show
is playing, the snapshot displays within the size of the placeholder box as defined in the slide. The
snapshot is frozen and cannot be updated or changed while the slide show is playing.

If you are playing the slide show and you see the placeholder box instead of the snapshot contents,
check the following:

o Make sure that the snapshot is not embedded in the first slide of the presentation. Ifit is, add
another slide before the snapshot slide and it should work as expected.

o Ifyou started the slide show on the slide with the embedded form, this is essentially the same as
being the first slide of the presentation and therefore the placeholder box will display. Either start
the slide show on a different slide, or move to another slide and then go back to the slide with the
embedded form (this will trigger the form to display).

NOTE: If you have a form snapshot that was taken prior to version 7.0 embedded in a PowerPoint
presentation, you should update that snapshot after upgrading using Update Snapshot. Snapshots
that are not updated may not display as expected when viewing the presentation.

While the slide show is playing, the placeholder boxes in the PowerPoint file (designer mode) will render
as black and unusable. You cannot make edits to the file while the slide show is playing. Once you have
closed out of the slide show, the placeholder boxes should return to normal and can be manipulated.
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Using live Axiom forms in PowerPoint files

You can embed a live Axiom form into a PowerPoint slide. This requires a live connection to Axiom
Software to display the form within the PowerPoint presentation. This approach behaves as if the
PowerPoint slide contains a web browser that is connected to the Axiom Software Web Client.

Embedding a live Axiom form in a PowerPoint slide

You can use the Axiom add-in for PowerPoint to embed a live Axiom form into a PowerPoint slide. If this
add-in is not already installed, see Installing the Word or PowerPoint add-in.

1. Open the PowerPoint file in which you want to embed the Axiom form, and navigate to the slide
where you want to place it. This can be any PowerPoint file; the PowerPoint file does not have to
be stored in the Axiom database.

IMPORTANT: Do not embed the Axiom form in the first slide of the PowerPoint file. The form
will not display as expected if it is located in the first slide.

2. Onthe Axiom tab, in the Axiom Forms group, click Add Live Form.
If you are not already logged into Axiom Software, you will be prompted to log in.

3. Inthe Choose Document dialog, navigate to the Axiom form that you want to embed into the
PowerPoint slide, and then click OK.

You can select any form-enabled file from the Reports Library or in a file group (that you have
rights to access). The selected file will always display as a form within the PowerPoint presentation.

A placeholder box is added to the PowerPoint slide, displaying the name of the live Axiom form that you
embedded. You can move and resize this box as needed within the slide.

The contents of the Axiom form do not display in "designer" mode within PowerPoint—you will only see
the placeholder box. The only time that you can view the Axiom form is when playing the PowerPoint
slide show.

NOTE: You cannot manipulate the embedded form in the PowerPoint slide while the slide show is
also playing. If you want to make a change to the placement or size of the embedded form, you
should close the active slide show, make the change in the PowerPoint designer, and then restart the
slide show.

Behavior of the embedded snapshot when playing the PowerPoint slide show

The content of the Axiom form is only visible when playing the PowerPoint slide show. While the slide
show is playing, the Axiom form displays within the size of the placeholder box as defined in the slide.

The Axiom form is live and behaves as if the PowerPoint slide contains a web browser that is connected
to the Axiom Software Web Client. You can change options in the form and refresh it on-the-fly from
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within the PowerPoint slide show. You can also use the Web Client "curtain" menu to open a different
Axiom form or navigate to your Web Client home page.

You must be logged into Axiom Software in order to display the live form within the PowerPoint slide
show. If you are not already logged into Axiom Software when you start the slide show, then the slide will
display a login screen instead of the form contents. You can then log into Axiom Software to display the
form.

If you are playing the slide show and you see the placeholder box instead of the form contents, check the
following:

o Make sure that the form is not embedded in the first slide of the presentation. Ifit is, add another
slide before the form slide and it should work as expected.

o Ifyou started the slide show on the slide with the embedded form, this is essentially the same as
being the first slide of the presentation and therefore the placeholder box will display. Either start
the slide show on a different slide, or move to another slide and then go back to the slide with the
embedded form (this will trigger the form to display).

While the slide show is playing, the placeholder boxes in the PowerPoint file (designer mode) will render
as black and unusable. You cannot made edits to the file while the slide show is playing. Once you have
closed out of the slide show, the placeholder boxes should return to normal and can be manipulated.

Disabling or uninstalling the Word or PowerPoint add-in

You can disable or uninstall the Word or PowerPoint add-in if you no longer want the Axiom tab to
display in Word or PowerPoint. Each add-in is controlled separately from within Word or PowerPoint.

If you disable or uninstall the add-in, and then later you open a read/write Word or PowerPoint file from
within Axiom Software, the add-in will be automatically re-enabled or re-installed.

To disable or uninstall the add-in:

1. Within Word or PowerPoint, go to File > Options.
2. Inthe Options dialog, click Add-Ins.

3. Atthe bottom of the Add-Ins screen, verify that Manage is set to Com Add-ins, then click Go.

b

In the Com Add-Ins dialog, do one of the following:

o To disable the add-in, clear the check box for Axiom EPM by Axiom EPM. This will hide the
Axiom tab from the ribbon, but will not uninstall the add-in. You can re-enable the add-in
later using this same dialog.

o To uninstall the add-in, select Axiom EPM by Axiom EPM (so that it is highlighted in the list
of add-ins), and then click Remove.
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Reference

Axiom grids
Axiom grids are used in dialogs throughout Axiom Software, to display lists of information. These grids
offer many ways to group and filter the information.

Dept E Cescription |E| Regicn |E| Country |E| VP E

11000 Balance Sheet Corporate UsA Michelle Choi
20000 Corporate Corporate UsA Michelle Choi
21000 Corporate Administration Corporate 54 Cconnor
22000 Information Techneologies Corporate UsA Frank Martinez

You can change the order of columns by dragging and dropping, and you can sort by clicking a column
header.

Filtering the list

Filtering can be especially helpful when you need to select items to include in a utility or other process.
Generally, you can filter the list to show a subset of items, and then select only the items that are shown

in the dialog.

To filter a column, click the down arrow button |;] in the column header. This brings up a grouping and

filtering dialog for the column.

The filtering options depend on the type of column. Use one of the following:
o Equality: Select a value to show items that exactly match that value. You can select multiple values
to match.
e Contains: Type a value to show items that contain that value. For example, to show all
departments with the text "Overhead" somewhere in the name.
o Range: Specify a range of values to show items that fall within the range (inclusive). For example,
to display all departments from 20000 to 30000.

Columns are filtered as soon as you select a filtering option. The OK button on the grouping and filtering
dialog is only to close the dialog. You can press the ESC key to close the dialog and cancel the filter.
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Once a column is filtered, the arrow button changes to show a filter icon @, so that you know the
contents of the column are filtered. You can define filters for multiple columns.

To clear a filter for a single column, click the filter button in the column header, and then click Clear
Filters. To clear all filters, right-click in the column header and select Clear All Filters.

For example, if you want to filter the list to show a specific subset of departments, you could set a range
as follows:

La) Process Plan Files ?
—_—
?,’3 Process Plan Files for Budget 2017
Options | Plan Files | Axiom Queries
Specify plan files ta process: @ Choose from list (O Use filter ) All
Selected plan files: 0
[]  Dept ’-_T‘ = — i T'le Exists E Country |E| Region |E| VP E Locked By E
0 20000 | Group By WUE UsA Corporate Michelle Choi
0 21000 | Clear Filters | UE USA Corporate Michelle Choi
0 22000 UE Usa Carporate Bree Sigman
O 23000 Equality WE USA Corporate Michelle Choi
O 24000 ] 10000 IUE USA Corpaorate Michelle Choi
] 25000 (11000 HWE usa Corporate Bree Sigman
O 28000 (20000 tUE UsA Corparate Michelle Choi
O 27000 [J21000 WE Usa Corporate Michelle Choi
0 28000 (122000 IUE USA Corporate Michelle Choi
] 29000 (123000 WUE Usa US West Bree Sigman
[ 24000
] 25000
[ 26000
QK
127000 =
Range
From | 20000
To |30000 |

If you only want to run the utility on this subset of departments, you can select the check box in the
header, and only the displayed departments will be selected.

If all of these departments belonged to the same region, or had the same VP, you could achieve the
same effect by filtering on the Region or VP column, but this time selecting a specific region or VP to filter
the list.

Grouping the list

To group the information by a column, click the button in the column header (it is either an arrow button
or a filter button, depending on whether the column has been filtered), and then click Group By.

User Guide Axiom Software | 128



The list is grouped by the selected column:

o To expand a grouping and see the items in a group, click the down arrow by a group name.

o To contract a grouping and hide the items in a group, click the up arrow by a group name.

Once the list has been grouped, a group icon appears in the column header i (not on the button) to
signal which column the list is grouped by. Only one level of grouping can be applied; if you choose to
group by a different column, then the current grouping is cleared and the new grouping is applied.

To clear a grouping, click the button in the column header of the grouped column, and then click Clear
Grouping. You can also right-click the column header and select Clear All Groupings.

For example, you could group the Browse Reports Library dialog by folder path:

©

ID Browse Reports Library

Reports Library

< |

Folder Path T IE‘

YAxiom\Reports Librany\Budget Reports
“Axiom\Reports Librany\Budget Reports
“Axiom\Reports Librany\Budget Reports
“Axiom\Reports Librany\Budget Reports
“Axiom\Reports Librany\Budget Reports
“Axiom\Reports Librany\Budget Reports
“Axiom\Reports Librany\Budget Reports
“Axiom\Reports Librany\Budget Reports

Document Name IE‘
@ \Axiom\Reports Library\Budget Reports\Archive: & item(s)
» | \Axiom\Reports Library\Budget Reports: 8 item(s)

Income Statement By Month
Monthly report package

Tie out monthly data
Budget Comparison
Variance by Account_nested
Dynamic Ranges stacked
Dept Subtotals

Acct Subtotals

@ \Axiom\Reports Library\Data Explorers: 2 item(s)
@ \Axiom\Reports Library\Forms\Archive: 28 item(s)
() \VAxiom\Reports Library\Forms\GEO: 4 item(s)

Type

xlsx
xlsx
xlsx
xlsm
xlsm
xlsm
xlsm

xlsm

E‘ Locked By

E Description [

QK Cancel

Hiding and showing columns

In most grids, you can hide columns and you can display additional columns.

o To hide a column, right-click the header for that column, and select Hide ColumnName. You

cannot hide a column ifit is the key column for the list.

e To show a column, right-click anywhere in the column header to bring up the list of available
columns, and then select the desired column to add it to the grid. You can also hide columns using
this list, by clearing the check box next to the name of the column that you want to hide.

Column changes apply to the current dialog session only. The next time that you open the dialog, the

default columns display.
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Axiom Software system information

The Axiom Software About box displays information such as:
o Platform version number
o Current logged in user
o Install directory
« Database server and database name
o Application server URL
o License information (number of users, expiration)
e Product feature versions (if any are installed)

To view information about your Axiom Software system:

e Onthe Axiom tab, in the Help group, click the down arrow at the bottom of the Help button, and
then click About.

The information is presented in a text box, so that it can be copied and pasted into an email and sent to
Axiom Software support if necessary.

You can also update your license file from this location, by clicking the Update License link at the top of
the dialog.
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